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Avant-propos 
 

Grâce à la généralisation des aspects de “Cloud-computing” de nombreux services et                       
applications de qualités sont maintenant disponible sur le web. Dans cette optique, il est                           
intéressant de se poser la question lors du choix des différents outils et services à utiliser pour                                 
gérer la plupart de ses documents numérique. Le choix d’une suite bureautique fait                         
notamment partie de la donne. 

Dans ce secteur, les solutions de Google sont une véritable alternative en comparaison des                           
suites comme la suite Office de Microsoft ou encore les solutions libres OpenOffice ou Libre                             
Office. Google propose ainsi des services simple, efficace, d’une grande qualité et cela                         
gratuitement pour les particuliers. 

Ainsi Je vous propose dans ce guide de découvrir en détail les applications bureautique de                             
Google pour utiliser et maîtriser pleinement les outils. 

Préconisation  : afin de  profiter pleinement des applications de Google, je vous conseille 
d’utiliser le navigateur Chrome qui est complètement optimisé pour ces outils. 

Cependant, rien ne vous empêche d’utiliser d’autre navigateur comme Firefox, Safari ou 
encore Edge  (Le remplaçant d’Internet Explorer). 
 

Information : Pour aller plus loin avec les Gsuite, je vous propose également sur la chaîne                               
Youtube NumeriTube   
( https://www.youtube.com/channel/UCuVW0pl83QgawEaNepFlh7A ) des tutoriels avec       
des cas pratiques. Ces cas permettent notamment de mettre en application les différentes                         
fonctionnalités présentes dans ce document. 
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Google Drive : Gérer et stocker ses documents 
 

Pour utiliser pleinement des applications bureautique Google, je vous conseille de                     
commencer par créer un compte Google Drive. Voici avant de vous lancez une petite                           
présentation de l’outil de gestion et de stockage en ligne de Google. 

Information  : Google Drive ne sera pas vu en détail dans ce livre afin de développer 
pleinement les outils bureautique et leur utilisation . L’introduction à Google Drive à 
comme objectif de vous donnez une vision “globale” de la solution. 
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Google Drive c’est quoi ? 
Le service Google Drive est un espace de stockage de type “Cloud” qui vous permet de                               
disposer d’un espace de stockage gratuit de 15Go (pour les particuliers avec une adresse                           
Gmail.com) ou 30 Go/illimité pour les entreprises, associations, écoles, afin de sauvegarder                       
vos données sur internet. Grâce à cette solution, vous pouvez garder vos documents ou une                             
copie de vos documents en sécurité sur le Cloud. 

Création et édition de documents 

Grâce au Drive, vous pouvez créer, éditer et gérer les fichiers bureautique de Google que                             
nous allons développer dans ce livre. Vous n’avez ainsi besoin d’installer aucun logiciel sur                           
votre PC ou votre Mac pour créer des documents bureautique. 

Information  : Il est également possible d’éditer de façon basique des fichiers de la suite 
Office Microsoft depuis le Drive. Il faut cependant ajouter une extension à Google Chrome 
(éditeur office pour docs sheets and slides).  

 

Partage et collaboration 

L’une des grandes force de la suite bureautique de Google se trouve dans les nouveautés en                               
termes de collaboration et de partage . Vous pouvez ainsi grâce à ces fonctionnalité                         
partager et éditer simplement des documents Google avec vos ami(e)s ou vos collègues                         
de travail. 

Nous développerons plus ces aspects lors de la découverte des applications dans les                         
chapitres suivants. 
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Comment créer un compte Drive ? 
Pour créer un compte Google Drive, il vous suffit de faire une recherche sur internet avec les                                 
mots clés “Google Drive” ou encore depuis l’URL suivante :  

https://www.google.com/intl/fr_fr/drive/ est de suivre la procédure pour créer votre                 
compte gratuitement. 
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Google Docs : Traitement de texte 
 

Environnement de Google Docs 
Google Docs est une solution de traitement de texte qui vous permet de créer des                             
documents dans une interface épurée et simple d’utilisation. Vous pouvez grâce à cette                         
solution créer des documents, les mettre en forme grâce à un large choix de paramètres et                               
de fonctionnalités. 

Outre l’aspect de traitement de texte, vous pouvez grâce à Google Docs partager très                           
facilement vos documents et ainsi collaborer plus efficacement avec vos collègues. 

Afin d’utiliser cette solution au mieux, nous allons voir dans ce document comment                         
fonctionne un document Google de base est voir en détail la plupart des fonctionnalités                           
présentes. 

 

 

 

   

 

 

 

 
 

8/125 



 

Composition d’un document Google Docs 

Un document Google Docs est de plusieurs zone distinctes. En plus du titre du document, il                               
est possible de découper les zones en 4 parties développées ci-dessous : 

- La barre de menu  permet de chercher plus en détails diverses fonctionnalités : 

 

- La barre d'outils permet de modifier votre texte ou la mise en forme rapidement. Cette                             
barre peut vous proposer des options différentes selon l’emplacement de votre                     
sélecteur (Tableau, image, etc…). Vous pouvez également choisir le mode d’accès du                       
document (Édition, Suggestion, affichage). 

 

- La règle de mise en page qui permet de visualiser et de modifier l’emplacement des                             
marges, retraits et des tabulations. 

 

- La zone de collaboration vous permet d’ajouter des commentaires de partager sur le                         
document ou encore de modifier le mode d’édition (Édition, Suggestion, Affichage). 
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Enregistrement d’un document 

Sur les document Google (Docs, Sheets, Slides, etc..) l’enregistrement se fait                     
automatiquement . Vous n’avez ainsi plus à vous inquiétez de cette tâche récurrente et                         
sensible. 

Mode plein écran et compact 

Pour consulter votre document sans la barre d’outils ni les menus, procédez comme                         
ci-dessous : 

- Affichage compact  : menu Affichage > Mode Compact  ou la combinaison Ctrl+Maj+F. 

- Affichage plein écran  : menu Affichage > Plein écran  (Echap pour revenir à l’état initial). 

Information : Vous pouvez également cliquez sur le touche F11 de votre clavier pour                           
afficher votre fenêtre en plein écran également.  (Appuyez sur Echap pour quitter ce mode). 
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Manipulation et notion de base 

Créer un document 

Dans Google Drive, cliquez sur Nouveau, puis sélectionnez Google Docs. Un nouveau                     
document Google va alors s'ouvrir dans votre navigateur. Vous pouvez à présent le modifier. 

 

Renommer un document 

Cliquez sur Document sans titre pour donner un nom à votre document. (Vous pouvez                           
modifier le nom du document à tout moment en cliquant sur le titre). 

 

Créer un document à partir d’un modèle 

Si vous souhaitez utiliser un modèle pour créer plus rapidement un document, procédez                         
comme suit : 

1. Ouvrez un  nouveau document Google Docs. 

2. Faite ensuite Fichier > Nouveau > A partir d’un modèle. 

3. Il ne vous reste alors plus qu’à choisir un modèle depuis la liste présente dans la                               
nouvelle fenêtre affichée à l’écran.  

4. Cliquez sur Utiliser ce modèle pour l’appliquer à votre document. 
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Mise en forme du document 

Modification de la couleur du texte et de l’arrière plan 

Pour modifier la couleur de texte ou l’arrière plan d’un document  :  

1. Mettez le bloc de texte concerné en surbrillance. 

2. Cliquez sur le bouton  depuis la barre d’outils. 

3. Sélectionner ensuite Texte ou Arrière-plan et choisissez la couleur. 
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Taille et espacement du texte 

Pour modifier la taille du texte , sélectionnez celui-ci et cliquez sur le bouton                           
précisant la taille actuelle  (11pt par défaut). 

Pour modifier l’interligne du document ou ajouter un espacement avant ou après un                         

paragraphe, cliquez sur le bouton  présent dans la barre d’outils. 
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Styles de paragraphes et titres 

Le menu Styles présent dans la barre d'outils affiche le style du texte sélectionné dans un                               
document et vous permet de le modifier ou de supprimer la mise en forme.  

Pour afficher la liste des titres , cliquez sur le menu qui se trouve à gauche du menu Police                                   
de la barre d'outils ou cliquez sur Format > Styles de paragraphe .  

Sélectionnez ensuite l'un des styles proposés, classés de "Titre 1" (le plus grand) à "Titre 6"                               
(le plus petit). 

Pour modifier la mise en forme d’un Titre, commencer par modifier la mise en forme du                               
texte à modifier, puis faite un clic-droit > Mettre à jour “Titre 1” en fonction de la sélection...  

Appliquer un format existant 

Pour appliquer un format déjà existant d’un bloc de texte à un autre, procédez comme suit : 

1. Sélectionnez le bloc de texte à modifier. 

2. Cliquez sur le bouton . 

3. Puis sélectionnez le bloc de texte ou appliquer la mise en forme. 

Pour appliquer le même format à plusieurs parties d’un document, double-cliquez sur le                         
bouton avec le rouleau de peinture pour activer et appliquer la mise en forme plusieurs fois                               
de suite. Pour désactiver, cliquez à nouveau sur le bouton. 

Ajouter des Listes à puces, des numérotation, des retraits 

Afin de rendre votre document plus clair et lisible, vous avez la                       
possibilité d’ajouter des listes à puces, des numérotation ou encore                   
des retraits à certaines parties d’un document Google Docs. 

Il vous suffit pour cela de sélectionner l’une des ces possibilités                     
depuis la barre d’outils. 
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Insertion d’éléments 

Insérer un lien 

Pour ajouter un ou des lien(s) dans un document Google Docs, il vous suffit de procéder                             
comme suit : 

1. Sélectionnez le contenu (texte, image, etc.) auquel vous souhaitez associer un lien. 

2. Cliquez sur l'icône de lien dans la barre d'outils ou clic-droit > lien  ou Ctrl + K. 

3. Saisissez maintenant l'URL de destination ou faite une recherche sur le web depuis                         
ce même champ.  

4. Enfin cliquez sur Appliquer . 

 

Information : Vous pouvez par l’intermédiaire d’un lien faire référence à différents types de                           
contenu comme une page internet, un autre document (Docs, Sheets, Slides, etc…) ou                         
encore un chapitre précis de votre document. 
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Insérer des images 

Si vous souhaitez insérer une image et la mettre en forme dans votre document, procéder                             
comme suit : 

1. Cliquez sur Insertion > Image. 

2. Sélectionnez une image. Vous pouvez importer une image depuis votre ordinateur, en                       
sélectionner une dans Google Drive ou vos albums photo, en rechercher une image sur                         
le Web ou prendre un instantané. Une fois l'image ajoutée, vous pouvez la supprimer                           
ou la redimensionner à tout moment. 

3. Pour supprimer une image, sélectionnez la, faites un clic-droit (ou                   
cliquez sur Édition), puis choisissez Couper ou cliquez sur la touche                     
“Suppr.” 

4. Pour redimensionner une image, cliquez dessus, puis faites glisser                 
l'une des poignées de sélection. Utilisez les poignées d'angle pour                   
redimensionner une image tout en en conservant les proportions.                 
Utilisez les poignées du haut, du bas ou latérales pour modifier une seule dimension. 

5. Vous pouvez enfin intégrer votre image de différentes façon dans le document                       
(Aligner, Envelopper, Intercaler). 
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Ajouter une bordure à une image 

Pour ajouter une bordure à une image, cliquez sur celle-ci et utilisez les options disponibles                             
depuis la barre d’outils . Dans ce cas, il ne suffit que de sélectionner une couleur et une taille                                   
de bordure . 

 

Insertion d’autres contenu 

Vous pouvez également insérer d’autres types de contenu dans votre document Google                       
Docs. Voici la liste des éléments qu’il vous est possible d’insérer depuis le menu Insertion                             
présent dans la barre d’outils : 

- Équation. 

- Dessin : depuis l’application Google Drawings 

- Tableau : *développé plus bas dans le document… 

- Note de bas de page :  pour des références externes. 

- Caractères spéciaux. 

- Ligne horizontale. 

- Numéro de page/Nombre de page. 

- Saut de page : atteindre directement la page suivante. 

- En-tête/Pied de page. 

- Signet  : raccourcis vers un emplacement du document. 

- Table des matières : insertion d’une table avec tous les                   
titres. 
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Tableaux et encadrements 
Nous allons voir dans cette partie les différentes notions autour des tableaux et des                           
encadrements. En effet, pour le moment la seule façon de mettre en place des encadrements                             
dans Google Docs est de passer par l’utilisation de tableau. 

Ajouter un tableau 

Les tableaux constituent un excellent moyen d'organiser les               
informations de votre document.  

Pour insérer un tableau dans votre document, procéder               
comme suit : 

1. Cliquez sur Tableau > Insérer un tableau. 

2. Indiquer le nombre de lignes et de colonnes souhaitées. 

Information : Pour colorer les cellules (comme la ligne supérieure ci-dessus), sélectionnez                       
le texte d'une ou plusieurs cellules, cliquez sur Tableau > Propriétés du tableau, puis                         
définissez la couleur d'arrière-plan des cellules. 
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Fusionner les cellules d’un tableau 

Pour fusionner les cellules d’un tableau dans votre document                 
Google Docs, il vous suffit de sélectionner les cellules à                   
fusionner et de faire un clic-droit et de sélectionner “Fusionner                   
les cellules” . 

Pour annuler la fusion, sélectionner les cellules concernées, puis                 
clic-droit et “Défusionner les cellules” . 

Redimensionner un tableau  

Pour redimensionner un tableau, il vous suffit d'utiliser le sélecteur en plaçant votre souris                           
sur l’une des lignes ou colonnes de votre tableau. Rester ensuite cliquez avec le clic gauche                               
de votre souris et déplacer la ligne ou la colonne  comme bon vous semble. 

Vous pouvez également définir plus précisément la taille de votre tableau avec clic-droit >                           
Propriétés du tableau… 
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Définir le style des cellules 

Vous pouvez également définir un style spécifique aux différentes bordures et cellules de                         
votre tableau. 

Pour modifier les contours d’une cellules, placez votre sélecteur dans une cellule puis                         
modifier la mise en forme avec les icônes de tableau présentes dans la barre d’outils. 

Pour modifier simplement le contour du tableau, sélectionner celui-ci et faite un clic-droit >                           
Propriétés du tableau… 
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Paramètres de page et Impression 

Table des matières / Plan de document 

Pour afficher le plan de votre document (table de matière), cliquez                     
sur Outils → Plan du document.  

Vous pourrez alors visualiser les différents titre enregistrer depuis                 
un menu défilant à gauche de votre texte. 

Pagination et sauts de page 

Depuis Google Docs, vous pouvez afficher vos documents sous                 
deux formats différents qui sont affichage paginé et affichage                 
compact . Ces types d’affichages permettent d’avoir une meilleure idée de ce à quoi                         
ressemblera votre document une fois imprimé. 

Par défaut, un document se trouve en affichage paginé. Pour modifier l’affichage, cliquez sur                           
le menu Affichage > Mise en page . Vous passerez alors automatiquement en affichage                         
compact . 

Notes de bas de page et pagination 

En affichage paginé, les notes apparaissent comme elles seront imprimées en bas de la                           
page. Pour voir une note de bas de page, double-cliquez sur le numéro de la note                               
correspondant dans le corps du document. 

En affichage compact, les numéros des notes de bas de page apparaissent dans le corps du                               
document mais les notes sont masquées en bas de chaque page. Si vous insérez une note de                                 
bas de page depuis ce mode, vous passerez automatiquement en mode d'affichage paginé. 
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Insertion de saut de page 

Pour insérez un saut de page afin de travailler sur la page suivante, cliquez sur le menu                                 
insertion > Saut de page . 

 

Pour supprimer un saut de page sélectionnez-le et appuyez sur la touche “Retour arrière” ou                             
“Suppr”. 

Information : Lorsque vous modifiez le type d’affichage (paginé > compact) ce paramètre                         
est alors enregistré par défaut dans tous les documents que vous ouvrirez par la suite. 
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Configuration de la page 

Pour configurer et contrôler précisément l'emplacement de votre texte sur votre document.                       
Vous pouvez définir l’emplacement du texte depuis la règle présente en haut de votre                           
document, qui vous permet de définir des marges, des retraits et des tabulations : 

 

Les marges 

Les marges définissent la mise en forme de tout le                   
document.  

Vous pouvez la modifier depuis la règle vu précédemment                 
ou encore depuis le menu Fichier > Configuration de la                   
page . 

Lorsque vous avez personnalisé vos marges, vous pouvez               
cliquer sur Définir comme valeurs par défaut pour adapter                 
cette mise en page à tous les nouveaux documents que                   
vous allez créez. 

Les retraits 

Les retraits peuvent être modifiés au niveau des paragraphes. Pour régler le retrait pour                           
plusieurs paragraphes, sélectionnez le texte approprié et définissez le retrait voulu. 

- Retrait de la première ligne : Le petit rectangle sur la règle qui permet d'ajuster la                               
position de départ d'un paragraphe et peut être modifié pour chaque paragraphe. 

- Retrait à gauche : s'applique à la deuxième ligne d'un paragraphe, ainsi qu'aux                         
suivantes. Pour le contrôler, faites glisser le triangle pointant vers le bas le long de la                               
règle. 

- Retrait à droite : retrait contrôlé à l'aide du triangle pointant vers le bas placé à                               
l'extrémité droite, définit la longueur d'un paragraphe jusqu'au bord droit de la page. 
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Numéro et nombre de page 

Pour ajouter un des numéros de page à votre document, cliquez sur le                         
menu Insertion > Numéro de page et sélectionnez l’une des quatre                     
propositions présentes. Les numéros de pages seront alors ajoutés                 
automatiquement. 

Pour supprimer un numéro de page, cliquez directement sur la zone de                       
numérotation et puis supprimer les numéros. 

Pour ajouter le nombre de pages présentes dans un document, placez vous tout d’abord à                             
l’endroit ou vous souhaitez voir apparaître le nombre (en-tête, pied de page) et cliquez sur le                               
menu Insertion > Nombre pages. 

 

Paramètres de zoom 

Pour régler le paramètre de zoom, il vous suffit de cliquez sur le bouton et de                                 
sélectionnez le pourcentage d’affichage qui vous convient le mieux. 
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Impression et téléchargements 

Si vous avez besoin d’imprimer ou de télécharger un document Google Docs, vous en avez la                               
possibilité en procédant comme suit : 

Mise en page et impression 

Pour imprimer, vous pouvez soit cliquer sur le bouton imprimante dans la barre d’outil ou                               
encore faire Fichier > Imprimer. Vous aurez alors la fenêtre de paramètres d’impression qui va                             
s’afficher. 

Vous pouvez notamment personnalisé le résultat de l’impression               
: 

- Destination : Choisir l’imprimante par sur laquelle             
imprimer. 

- Pages :  Imprimer toutes les pages ou une parties. 

- Taille du papier : Choix du format d’impression. 

- Marges : Choix du type de marges. 

- Options : Activer ou non des options comme les entêtes et                     
pieds de page, l’impression recto-verso ou encore les               
graphiques d’arrière-plan. 

 

Téléchargement 

Vous pouvez également télécharger votre document Google Docs en                 
différent format. 

Il vous suffit pour cela de faire Fichier > Télécharger au format et de                           
sélectionner le format souhaité. 
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Révision et historique des fichiers 

Si vous souhaitez voir les modifications apportés à un document par vous ou d’autres                           
personnes, vous pouvez consulter l’historique des révisions. Celui-ci vous permet de                     
consulter et de rétablir des versions précédentes du fichier, mais également de voir qui a                             
apporté les dernières modifications. 

Historique des révisions 

Pour consulter l’historique des révisions et ainsi visualiser les                 
différentes versions de votre document, cliquez depuis la barre de                   
menu sur Fichier > Consulter l’historique des révisions. Vous pouvez                   
également accéder à ce menu en cliquant sur le bouton à droite du                         
menu “Aide”  ou encore avec le raccourci clavier “Ctrl+Alt+Maj+G” . 

Vous allez alors pouvoir visualiser et sélectionner l’une des                 
différentes versions du document en sélection la date et l’heure                   
indiqué sur le panneau à droite. En dessous figure également le                     
nom des personnes à l’origine des modifications. 

Les flèches en haut à droite vous permettent également de faire défiler les modifications par                             
ordre chronologique. Le modification apparaîtront alors dans une autre couleur que la couleur                         
d’origine et le texte supprimé en barré. 

 

Pour rétablir une version, il vous suffit de cliquez sur Restaurer cette version après avoir                             
sélectionné la date en question. Pour revenir à la version actuelle, cliquez sur la flèche de                               
retour en haut à gauche de l’écran. 

Information : Lors de la restauration d’un document à une date antérieure, vous n'écrasez                           
en aucun cas les versions plus récente. Cette version viendra simplement ce placer en haut                             
de liste de l’historique des versions. 
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Afficher les dernières modifications 

Dans le cas où vous travaillerez avec d’autres personnes sur un document, vous pouvez                           
afficher les dernières modifications apportées, cliquez depuis la barre de menu sur Fichier >                           
Voir les nouvelles modifications. 

Utilisez ensuite les flèches présentes en haut à droite pour                   
faire défiler la liste des modifications. Vous pourrez alors                 
visualiser les modifications en surbrillance. Le texte supprimé               
sera barré. 

Information : Pour le moment cette fonctionnalité n’est pas disponible pour les documents                         
de type Sheets & Slides. 

 

Impossible d’afficher une version précédente 

Dans certains cas les révisions de votre fichier peuvent être fusionnées afin d’économiser de                           
l’espace de stockage. Généralement lorsque le fichier est ancien ou lorsque les révisons                         
prennent beaucoup d’espace de stockage. 

Information : Il est uniquement possible d’utiliser l’historique des révisions si vous avez                         
accès en modification au document. Les utilisateurs en lecture ou commentaire n’y ont pas                           
accès. 
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Partage et collaboration 
Partagez votre document Google Docs avec d'autres             
personnes et profitez des fonctionnalités collaboratives de             
celui-ci. Plusieurs personnes peuvent modifier un document             
Google Docs simultanément. 

Pour partager votre fichier Docs, cliquez sur le bouton Partager en haut à droite de la page.                                 
Pour en savoir plus sur les paramètres de partage, consultez le document Partager et                           
collaborer . 

Commentaires et discussions 

Une fois qu’un document est partagé avec une ou plusieurs autres                     
personnes, vous avez la possibilité d’échanger des informations               
directement sur le document.  

Cette fonctionnalité et très intéressante afin d’avoir l’avis d’autres                 
personnes sur son contenu. 

Ajouter un commentaire 

Pour ajouter un commentaire sur une partie de texte ou même simplement un terme                           
sélectionner d’abord la partie concernée puis vous pouvez choisir l’une des méthodes                       
suivantes pour afficher la fenêtre de commentaire :  

- Cliquer sur le bouton  depuis la barre d’outils 

- Menu Insertion > Commentaires . 

- Combinaison de touches “ Ctrl+Alt+M” . 

Saisissez votre commentaire dans la fenêtre qui s’affiche puis cliquez sur “commenter” pour                         
enregistrer le commentaire. 

Modifier ou supprimer un commentaire 

Pour modifier ou supprimer un commentaire, il vous suffit de                   
cliquez sur les trois points verticaux et de sélectionner l'option                   
souhaitée. 
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Envoyer un commentaire à une personne spécifique 

Pour envoyer une remarque à une personne déterminée, lors de l’écriture de votre message                           
dans la zone de commentaire, ajoutez un signe “+” suivi de l’adresse e-mail de la personne                               
à qui vous souhaitez adresser le message. Ex : +john.doe@gmail.fr. 

Répondre ou fermer des commentaires 

Vous pouvez répondre à des commentaires ajoutés par               
d’autres personnes ou encore fermer les discussions             
lorsque celle-ci sont terminées. 

Pour répondre à un commentaire, il vous suffit de                 
sélectionner le commentaire en question et de cliquez sur                 
la zone de texte . Vous aurez alors accès à une zone                     
“Répondre”  pour ajouter votre réponse. 

Pour fermer un commentaire , sélectionner le commentaire             
puis cliquez simplement sur “Fermer la discussion” . 

Recevoir une notifications des commentaires  

Pour recevoir une notification par mail lorsque d’autres utilisateurs laissent un commentaires                       
dans un fichier Google Docs, il faut procéder comme suit : 

1. Cliquez sur Commentaires en haut à droite du document. 

2. Cliquez sur Notifications . 

3. Choisissez alors un paramètre de notification pour définir la fréquence vous souhaitez                       
recevoir des mails ( Tous les événements, réponses pour vous, désactivées). 
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Astuces et notions diverses 

Recherche / Remplacement 

Pour rechercher des informations précise dans un             
fichier Google Sheets, dans la barre de menu cliquez                 
sur Édition > Rechercher et Remplacer (Ctrl+H) . 

Depuis la fenêtre qui va s’afficher, vous allez pouvoir                 
recherche des éléments dans tout le fichier ou               
encore remplacer des mots. Pour cela, noter le mot à                   
remplacer dans “Rechercher” et le nouveau mot             
“Remplacer par” . 

Il ne vous reste plus qu’à remplacer les mots au fur et                       
à mesure “Remplacer” ou tous les mots d’un clic                 
“Tout remplacer” . 

Vérifier l’orthographe dans un document 

Pour vérifier si votre fichier Docs ne présente pas des                   
fautes d’orthographes et avoir des suggestions de             
correction, utilisez le correcteur orthographique. 

1. Cliquez sur la cellule ou les plages de cellules à                   
vérifier. 

2. Dirigez vous vers la barre de menu Outils >                 
Orthographe . 

3. Si le correcteur trouve un mot qui lui semble incorrect, il va vous proposez de le                               
remplacer . Si vous le souhaitez vous pouvez évidemment Ignorer la proposition. 

4. Pour terminer la vérification cliquer la croix X. 

Rechercher des fonctions 

Pour trouver rapidement une fonctionnalité ou autre             
depuis Google Docs, vous pouvez utiliser la fonction de                 
recherche présente dans la barre de menu > Aide. 
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Rechercher des éléments externe 

Vous pouvez depuis Google Docs intégrer des documents externe directement depuis                     
l’application. Pour cela, il vous suffit de cliquez depuis la barre de menu sur Outils >                               
Recherche. 

Un volet va alors apparaître sur la droite de votre                   
écran depuis lequel vous allez pouvoir chercher             
différents éléments à intégrer depuis internet, ou             
encore depuis votre Drive. 

Fonction très intéressante notamment pour         
trouver des images à intégrer. Celle-ci sont de               
plus libre de droit.  

 

Utiliser la saisie vocale 

Vous pouvez également depuis Google Docs utiliser la saisie vocale                   
(Outils > Saisie vocale) qui vous permet de dicter votre texte à haute voix                           
qui sera ensuite retranscris en texte sur votre document. 

Lors de la première utilisation de cette fonctionnalité, il vous faudra tout                       
d’abord autoriser l’outil à utiliser votre microphone. 

Récupérer le texte d’une image 

Avec Google Docs, vous pouvez récupérer le texte présent sur une image (ou un document                             
PDF) afin de l’éditer simplement sur un documents Docs. Tout cela grâce au système de                             
reconnaissance de caractère (OCR). 

Pour utiliser cette fonctionnalité, procédez comme suit : 

1. Transférer une image avec du texte sur votre               
espace Google Drive 

2. Faite un clic-droit sur le fichier 

3. Ouvrir avec Google Docs 

4. Un fichier Docs va alors être créé avec l’image                 
et le texte éditable. 
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Ajouter un Filigrane (image/texte arrière plan) 

Il n’est actuellement pas possible d’utiliser la fonction Filigrane depuis Google Docs.                       
Cependant, pour contourner le problème, vous pouvez utilisez la solution de dessin de                         
Google (Drawings). 

Cette méthode est notamment largement suffisante dans le cas d’un filigrane d’en-tête ou de                           
bas de page. Par exemple dans le cas ou l’on souhaite ajouter une image avec du texte par                                   
dessus, il faut procédez comme suit : 

1. Cliquez sur Insertion > Dessin. 

2. Charger alors votre image de fond avec l’icône image . 

3. Une fois l’image chargé intégrer une zone de texte par dessus et noter le                           
contenu . 

4. Il ne vous reste alors qu’à cliquez sur “Enregistrer et fermer”. 

5. l’image chargée ainsi que la zone de texte vont alors être intégrées à votre document                             
par l’intermédiaire d’une image. 
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Modules complémentaires 
Les modules complémentaires sont en quelque sortes des “extensions” pour Google Docs.                       
Vous pouvez ainsi grâce à ces modules améliorer et augmenter le potentiel de Docs. Voici                             
ci-dessous des exemples de modules qu’ils peut-être intéressant d’installer.  

 

Information : pour installer des modules directement depuis Google Docs, il vous suffit de 
cliquer depuis la barre de menu sur Module complémentaires → Télécharger les modules 
complémentaires. 

 

Gestion des étiquettes sur Google Docs 

La gestion d’étiquette n’est actuellement pas disponible en natif sur Google Docs. Cependant                         
grâce au modules “Avery Label Merge”, il est possible de gérer l’impression des étiquettes                           
aussi bien (voir mieux) que sur la solution Word de Microsoft.  

Publipostage - Mailing (Google Docs/Sheets) 

Le publipostage n’est actuellement pas disponible en natif sur Google Docs. Vous pouvez                         
cependant utiliser des modules complémentaires comme “autoCrat” pour faire du                   
publipostage. 

Réalisation de CV 

Si vous souhaitez réaliser simplement votre CV, le module complémentaire “VisualCV                     
Resume Builder” vous permet de disposer d’un grand nombre de modèles (templates) pour                         
réaliser simplement et efficacement le déroulé de votre parcours professionnel. 
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Google Slides : Présentation 
 

 

Environnement de Google Slides 

Google slides est une solution de création de diaporama qui vous permet de créer des                             
modèles de présentation simple et efficace. Vous pouvez notamment les modifier et travailler                         
sur des présentations à plusieurs. 
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Composition d’une présentation Google Slides 

Un fichier de présentation Slides ressemble beaucoup aux solutions les plus connus comme                         
la solution de Microsoft PowerPoint.  

La plupart des fonctionnalités “de base” sont actuellement disponible sur cette version. Nous                         
allons pour débuter, voir en détails comme se présente un fichier Google Slides vierge. 

- Barre des menus : Toutes les commandes disponibles sont accessible depuis ce                       
menu. 

- Barre d’outils : Permet de lancer des commandes avec un simple bouton. 

- Zone de visualisation des diaporamas : Permet de visualiser les diaporamas en                       
miniature dans l’ordre de défilement. 

- Zone des commentaires : Permet d’afficher des commentaires en rapport avec la                       
diaporama courante. 

- Zone de collaboration : Permet d’ajouter ou de visualiser des commentaires ou encore                         
de partager le document avec d’autres personnes. 
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Manipulation et notion de base 

Créer une présentation 

Pour créer une nouvelle présentation, cliquez sur “Nouveau”, puis                 
Google Slides  pour lancez la création. 

Pour donner un nom à votre présentation, cliquez sur Présentation                   
sans titre . Vous pouvez ensuite la renommer à tout moment en                     
cliquant à nouveau sur le titre. 

Convertir des fichiers PowerPoint (Office) en Google Slides  

Pour utiliser des fichiers PowerPoint conçu avec des applications différentes comme la suite                         
Office et pouvoir les éditer de Google Slides , vous devez les convertir. Voici la marche à                                 
suivre : 

1. Transférer vos documents sur le Drive. Nouveau > Importer un fichier. 

2. Une fois le fichier transféré, double-cliquez dessus pour l’ouvrir. 

3. Puis faite Fichier > Enregistrer au format Google Slides. 

Attention : La plupart des document PowerPoint basique peuvent être convertis sans aucun                         
problème vers Google Slides. Cependant, des fichiers complexes avec des effets ou de                         
grandes tailles peuvent ne pas être converti correctement. Vérifier bien vos fichiers après                         
conversion ! 
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Appliquer un modèle prédéfinis  

Suite à la création d’une nouvelle présentation, vous êtes invité à choisir un thème, afin de                               
définir un arrière-plan et des polices identiques sur l'ensemble de vos diapositives. 

Vous donnez ainsi plus de style et une apparence cohérente à votre présentation. Toutefois,                           
si vous le souhaitez, vous pouvez modifier le fond d'écran et les polices pour une diapositive                               
donnée.  

Vous avez également la possibilité de définir un autre thème par la suite si vous changez                               
d'avis. 

 
 

Bonus : si les slides proposés depuis la sélection ne vous conviennent pas totalement, je 
vous conseille d’aller jeter un coup d’oeil sur le site “Slide Carnival” . Je ne doute pas que 
vous trouverez votre bonheur sur ce site qui propose des templates d’une grande qualité. 
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Mise en forme d’un document Slide 

Modifier votre présentation 

Pour personnaliser votre présentation, utilisez la barre d'outils et de menu. 

 

Information : Si vous n'êtes pas en train de modifier du texte, tous les éléments illustrés ici                               
ne figurent pas dans la barre d'outils. Pour activer les options liées au texte, sélectionnez                             
une zone de texte dans votre présentation. 

Modifier les masques de diapositive 

Lors de la création d’une présentation, vous pouvez choisir plusieurs thèmes et mises en                           
page. Il vous est également possible de modifier ces thèmes et mises en page, afin d’utiliser                               
des styles personnalisés. 

Vous pouvez ainsi modifier la diapositive maître et les mises en page individuelles. 

La diapositive Maître 

Cette diapositive qui est associé à un thème a une utilité double. les paramètres qui s’y                               
trouvent contiennent les styles de texte par défaut utilisés dans la présentation. L’arrière-plan                         
et tous les autres forme présentes constituent l’arrière-plan par défaut de l’ensemble des                         
diapositives. 

Pour qu’une image/logo apparaisse sur chaque diapositive de votre présentation, vous devez                       
modifier la diapositive maître. 

Mises en page individuelles 

Les modèles de mise en page déterminent la façon dont le contenu est disposé sur chaque                               
type de diapositive. Ainsi, si vous souhaitez que toutes vos diapositives de titres aient une                             
disposition spécifique, il vous faudra modifier le modèle de mise en page de titre. 
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Modification d’un thème 

Pour modifier et appliquer un thème préétabli, il vous suffit de cliquez sur le bouton ,                               
ou encre depuis la barre de menu Diapositive > Changer de thème… 

Pour personnaliser complètement un thème déjà existant, il faut pour cela modifier les                         
modèles maître et mises en page. procédez alors comme ci-dessous : 

1. Cliquez sur le menu Diapositive > Modifier le masque. 

2. Vous aurez alors accès à l’éditeur de modèle maître. 

3. Pour modifier le maître ou l’une des mises en pages, sélectionnez la diapositive                         
correspondante dans la liste de gauche, puis appliquez les modifications.  

4. Lors de la modification du modèle maître et des mises en page, vous pouvez                           
également effectuer les actions suivantes : 

○ Insérer une nouvelle mise en page personnalisée 
○ Dupliquer une mise en page 
○ Supprimer une mise en page 

○ Insérer un espace réservé (Insertion > Espace réservé) 

5. Vos modifications seront automatiquement enregistrées. Pour quitter l’éditeur, cliquez                 
sur la croix “X” an haut à droite de la fenêtre. 

 

Les diverses modifications que vous aurez effectuées dans le modèle de masque vont                         
impacter l’ensemble des diapositives existantes de votre présentation, ainsi que toutes les                       
nouvelles diapositives que vous ajouterez. 
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Insertion, duplication et suppression 

Pour insérer, dupliquer ou encore supprimer une diapositive, il vous suffit de cliquez sur le                             
bouton “Diapositive” dans la barre de menu, ou encore de faire un clic-droit sur une                             
diapositive  et ensuite de sélectionner l’un des options souhaitée. 

Organiser et numéroter les diapositives 

Réorganiser les diapositives  

Pour modifiez l’ordre des diapositives, il vous suffit de sélectionner une diapositive et ensuite                           
de la faire glisser avec votre souris à l’endroit souhaité. 

Information : Pour sélectionner plusieurs diapositives à la fois, placez vous sur la première                           
diapositive appuyez sur la touche maj puis cliquez avec votre souris sur la dernière                           
diapositive de la série. Pour sélectionner plusieurs diapositives non consécutive,                   
maintenez la touche Ctrl enfoncée, puis cliquez sur les diapositives à déplacer. 

 

Numération des diapositives 

Pour numéroter les diapositives d’une présentation, il vous               
suffit de cliquez sur le menu Insertion > Numéros de                   
diapositives… 

Il ne vous reste alors qu’à choisir entre activer ou désactiver                     
la fonctionnalité , et dans la positive de choisir d’ignorer ou                   
non les diapositives de titre. 

Mettre en forme du texte 

Modifier la police 

Pour modifier la police dans un cadre de texte de votre présentation Google Slides, il vous                               
suffit de sélectionner votre texte puis de cliquez sur le bouton sélecteur de police                           

présente dans la barre d’outils afin de choisir une police différente (Arial par                         
défaut) . 

Modifier la couleur 

Pour modifier la couleur de texte ou de surbrillance dans une section spécifique, il vous suffit                               

de sélectionner le texte souhaité et de cliquez sur le bouton dans la barre d’outils et de                                   
sélectionnez “texte”  ou “Arrière-plan” et enfin de choisir une couleur. 
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Modifier la taille  de vos diapositives 

Pour modifier la taille des diapositives, cliquez sur Menu > Configuration de la page .  

Sélectionnez alors l’une des tailles proposées dans la liste                 
déroulante. Vous pouvez également spécifiez une dimensions             
personnalisée avec la champ “personnalisée” . 

 

Mettre en forme les listes à puces / listes numérotées 

Pour insérer des listes à puces ou des listes numérotées dans la zone de texte d’un                               

présentation, cliquez sur le bouton ou selon le type de liste souhaité. Pour choisir                               
un style de liste différent pour les liste à puces ou numérotées, cliquez sur la flèche pour                                 
obtenir plus de possibilités. 

Personnaliser une liste puces/numéroté 

Pour modifier les puces et les numéros d’une liste, que ce soit de manière individuelle ou                               
groupée. Tout d’abord, cliquez sur l’une d’entre elles pour sélectionner l’ensemble des puces                         
d’une liste, ou double-cliquez sur une puce pour ne sélectionner que cette dernière. 

Modifier le type des puces : Pour modifier le type d’une ou d’un                         
ensemble de puce, sélectionnez la(les) puce(s), puis faites un                 
clic-droit. 

Modifier la couleur des puces : Pour changer la couleur de                     

la(des) puce(s), cliquez sur l’icône dans la barre d’outils et                     
choisissez une couleur. 
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Insérer des éléments 

Insérer un lien 

Pour ajouter un ou des lien(s) dans Google Documents, il vous suffit de procédez comme suit : 

Sélectionnez le contenu (texte, image, etc.) auquel vous souhaitez associer un lien. Cliquez                         

sur l'icône de lien dans la barre d'outils ou clic-droit > lien ou Ctrl + K. Saisissez                             
maintenant l'URL, puis cliquez sur Appliquer . 

 

Information : Vous pouvez par l’intermédiaire d’un lien faire référence à différents types de                           
contenu comme une page web, une document (Docs, Sheets, Slides, etc…) ou encore un                           
chapitre de votre document. 
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Insérer des images 

Si vous souhaitez insérer une image et la mettre en forme dans votre document, procéder                             
comme suit : 

Cliquez sur Insertion > Image > Sélectionnez ensuite une image . Vous pouvez importer une                         
image depuis votre ordinateur, en sélectionner une dans Google Drive ou vos albums photo,                         
en rechercher une photo sur Internet ou prendre un instantané.  

Une fois l'image ajoutée, vous pouvez la supprimer ou la                   
redimensionner à tout moment. 

Pour supprimer une image, sélectionnez la, faites un clic-droit                 
(ou cliquez sur Édition), puis choisissez Couper ou cliquez sur la                     
touche Suppr. 

Pour redimensionner une image , cliquez dessus, puis faites               
glisser l'une des poignées de sélection. Utilisez les poignées d'angle pour redimensionner                       
une image tout en en conservant les proportions. Utilisez les poignées du haut, du bas ou                               
latérales pour modifier une seule dimension. 

Vous pouvez enfin intégrer votre image de différentes façon dans le document (Aligner,                         
Envelopper, Intercaler) . 

Ajouter une bordures à une image 

Pour ajouter une bordure à une image, cliquez sur celle-ci est utilisez les options disponibles                             
depuis la barre d’outils . Dans ce cas, il ne suffit que de sélectionner une couleur et une taille                                   
de bordure . 
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Insertion d’autres contenu 

Vous pouvez également insérer d’autres types de contenu dans votre document Google                       
Docs.  

Voici la liste des éléments qu’il vous est possible d’insérer depuis le menu Insertion présent                             
dans la barre d’outils : 

- Zone de texte. 

- Image. 

- Lien  : ajouter un lien à un élément. 

- Vidéo : intégrer une vidéo. 

- Word Art  : texte avec effet. 

- Trait : intègre différent type de trait comme des flèches,                   
connecteurs… 

- Forme : intègre des dessins pré-enregistré (Forme, Légende,               
flèche, équation). 

- Tableau : *développé plus bas dans le document… 

- Numéros de diapositives. 

- Commentaires. 

- Caractères spéciaux. 
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Tableau et encadrements 
Nous allons voir dans cette partie les différentes notions autour des tableaux et des                           
encadrements sur Google Slides. 

Ajouter un tableau 

Les tableaux constituent un excellent moyen d'organiser les informations de votre document.                       
Pour insérer un tableau dans votre document, procédez comme suit : 

1. Cliquez sur Tableau > Insérer un tableau. 

2. Indiquer le nombre de lignes et de colonnes               
souhaitées. 

Ensuite, procédez à la mise en forme du tableau et il ne vous                         
reste alors qu’à renseigner les différentes cases. 

 

Information : Pour colorer les cellules, sélectionnez le texte d'une ou plusieurs cellules,                         

cliquez sur Tableau > Propriétés du tableau (ou avec l’icône ) , puis définissez la couleur                           
d'arrière-plan des cellules. 
 
Exemple, tableau avec un fond vert : 
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Fusionner les cellules d’un tableau 

Pour fusionner les cellules d’un tableau dans votre document Google Docs, il vous suffit de                             
sélectionner les cellules à fusionner et de faire un clic-droit et de sélectionner “Fusionner                           
les cellules” . 

Pour annuler la fusion, sélectionner les cellules concernées, puis clic-droit et “Défusionner                       
les cellules” . 

 

Redimensionner un tableau  

Pour redimensionner un tableau, il vous suffit d'utiliser le sélecteur en plaçant votre souris                           
sur l’une des lignes ou colonnes de votre tableau. Rester ensuite cliquez avec le clic gauche                               
de votre souris et déplacer la ligne ou la colonne  comme bon vous semble. 

Définir le style des cellules 

Vous pouvez également définir un style spécifique aux différentes                 
bordures et cellules de votre tableau.  

Pour modifier les contours d’une cellules , placez votre sélecteur dans celle-ci puis modifier                         
la mise en forme avec les icônes de tableau présentes dans la barre d’outils. 
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Les différents mode d’affichage 

Lecture et prévisualisation 

Lorsque vous êtes prêt à prévisualiser ou à lire les                   
diapositives , cliquez sur le bouton Lire en haut à droite                   
de la page.  

 

Pour afficher d'autres options, cliquez sur la flèche vers le bas. 

 

Si vous déplacez la souris pendant la lecture du diaporama, une barre de commandes                           
s'affiche temporairement.  

Elle permet de passer à une autre diapositive, d'interrompre ou de reprendre la lecture du                             
diaporama, ainsi que d'activer et de désactiver le mode plein écran. 

  

Pour afficher  d'autres options , cliquez sur l'icône représentant une roue dentée. 
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Transition entres les diaporamas 

Afin de rendre votre présentation plus conviviale, vous avez la possibilité de choisir une                           
animation spécifique lors de la lecture de vos diaporamas. Vous avez notamment le choix                           
entre les animations suivantes : 

- Aucune transition 

- Fondu 

- Diapositive à partir de la droite 

- Diapositive à partir de la gauche 

- Retourner 

- Cube 

- Galerie 

Après avoir choisi une animation, vous pouvez définir la vitesse de transition (lente,                         
intermédiaire, rapide) ou encore choisir d’appliquer les modifications à toutes les diaporamas                       
ou non. 
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Mise en page et impression 

Pour imprimer des diapositives et choisir la mise en page, cliquez sur Fichier > Paramètres                             
d’impression et aperçu. 

Une nouvelle fenêtre va alors s’afficher avec l’aperçu de l’impression des diapositives sur les                           
feuilles.  

Depuis cette fenêtre, vous allez pouvoir choisir : 

- Le nombre de diapositive à afficher 

- Masquer ou non l’arrière plan 

- Télécharger le document en PDF 

- Imprimer le document 

 

Une fois que vous avez choisi les paramètres adéquate, cliquer sur Imprimer pour accéder à                             
la fenêtre d’impression.  

Il ne vous reste plus qu’à choisir vos paramètres d’impression (copie d’écran ci-contre). 
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Téléchargement 

Vous pouvez également télécharger le fichier en différent format. Il                   
vous suffit pour cela de faire Fichier > Télécharger au format et de                         
sélectionner le format souhaité. 

 

Trucs et astuces : En savoir plus 

Vous connaissez désormais les bases de la création d'une présentation Google Slides. Vous                         
souhaitez aller plus loin dans l’utilisation de l'application ? Voici dans ce chapitre quelques                           
trucs & astuces pour pourraient bien cous être utile. 

Cacher un slide 

La fonction cacher/masquer n'est actuellement pas disponible dans Google Slides.                   
Cependant, il existe une méthode pour contourner ce problème en attendant l'arrivée de                         
cette évolution. 

La méthode va être de placer les diaporamas à cacher à la fin du document et d'y accéder                                   
par l'intermédiaire de lien . 

1. Déplacez les diaporamas à cacher à la fin du document. 

2. Placez un premier lien de re-direction (zone de texte ou image) sur le slide précédent                             
le slide à masquer. 

3. Puis sur le slide caché ajoutez un lien de retour vers le slide suivant. 

4. Lors du lancement du diaporama il ne vous restera qu'à cliquer sur les différents liens. 
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Publier un Google slide sur le Web 

Depuis Google Slides, vous pouvez publier simplement une présentation sur internet. Pour ce                         
faire, cliquez sur Fichier > Publier sur le Web… 

Depuis la fenêtre qui va s’afficher, vous allez pouvoir de : 

- Le délai d’avancement des diapositives. 

- La taille de la présentation (en cliquant sur l’onglet Intégrer) . 

- Démarrer la présentation dès que le lecteur est chargé. 

- Redémarrer le diaporama à la fin de la présentation. 

 

Après avoir défini les paramètres, il ne vous reste qu’a cliquez sur Publier pour obtenir une                               
URL pour visualiser la présentation sur le Web.  
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Ajouter des polices à la liste de polices 

Si la langue paramétrée correspond à l’une des langues suivantes : 

- Anglais 
- Allemand 
- Catalan 
- Danois 
- Néerlandais 
- Finnois 
- Français 
- Italien 
- Norvégien 
- Portugais 

Pour ajouter des polices à la liste, il vous suffit d’ouvrir le                       
sélecteur de police et de cliquer sur Autres polices.  

Vous pourrez alors choisir et intégrer un plus grand nombre                   
de police à la liste. 
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Ajouter des commentaires d'intervenant 

Utilisez les commentaires d'intervenant afin de noter             
les points clés à aborder pour chaque diapositive.               
Dans l'éditeur de présentation, les commentaires           
apparaissent dans la zone de texte affichée sous la                 
diapositive actuelle. Cette zone contient le texte             
Cliquez ici pour ajouter des notes lorsque vous               
ajoutez une nouvelle diapositive. 

Si vous ne voyez aucun commentaire, cliquez sur le                 
menu Affichage et assurez vous que l'option Afficher               
les commentaires du présentateur est activée. 

Lors de la lecture du diaporama, les commentaires               
de l'intervenant s'affichent dans une fenêtre           
séparée, qui contient également des commandes permettant d'avancer dans les diapositives                     
ou d'interrompre la lecture.   
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Google Sheets : Tableur 
 

Environnement de Google Sheets 

Google Sheets est un tableur qui utilise une ergonomie la plus visible et simple possible. Elle                               
est donc composée d’une zone de menu avec les différents onglets (Fichier, Édition,                         
Affichage, etc..), d’une barre d’outils avec les options de mise en page et les fonctions                             
basiques et les plus utiles. 

La différence par rapport avec un tableur traditionnel se situe cependant au niveau du                           
partage et de la collaboration avec les boutons “commentaires” et “partager”.  

Nous allons voir en détails les différentes manipulations possibles et les fonctionnalités que                         
propose la solution de tableur de Google. 
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Composition d’un document Google Sheets 

Un document Sheets ressemble beaucoup à la plupart des tableurs présent depuis plus                         
longtemps sur le marché comme le fameux Excel de Microsoft.  

Voici un tour d’horizon d’une page vierge de l’application. 

- Barre des menus  : Toutes les commandes sont disponibles depuis ce menu. 

- Barre d’outils  : Permet de lancer des commandes avec un simple bouton. 

- Barre de formule  : Affiche le contenu de la cellule active. 

- Onglet(s) de feuille  : Choix de la feuille affiché à l’écran. 

- Zone de collaboration : Permet d’ajouter ou de visualiser des commentaires ou encore                         
de partager le document avec d’autres personnes. 
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Manipulation et notion de base 

Créer une feuille de calcul 

Dans Google Drive, cliquez sur le bouton Nouveau , puis Google Sheets                   
pour créer un nouveau classeur. 

Pour donner un nom à votre feuille de calcul, cliquez sur Feuille de                         
calcul sans titre.   

Vous pouvez ensuite la renommer à tout moment en cliquant sur le titre. 

Convertir des fichiers Excel en Sheets  

Pour utiliser des fichiers tableur conçu avec des applications différentes comme excel et                         
pouvoir les éditer de Google Sheets, vous devez les convertir. Voici la marche à suivre : 

1. Transférer vos documents sur le Drive. Nouveau > Importer un fichier. 

2. Une fois le fichier transféré, double-cliquez dessus             
pour l’ouvrir. 

3. Puis faite Fichier > Enregistrer au format Google               
Sheets . 

Attention : La plupart des document Excel basique peuvent être convertis sans aucun                         
problème vers Google Sheets. Cependant, des fichiers complexes avec des macros ou de                         
grandes tailles peuvent ne pas être converti correctement. Vérifier bien vos fichiers après                         
conversion ! 

 

Déplacement dans une feuille 

Outre la souris, Les flèches de direction de votre clavier permettent un déplacement de ligne                             
à ligne ou colonne à colonne. Vous pouvez aussi utiliser la barre de défilement droite et bas                                 
(ascenseurs) selon le fichier. 

Déplacement rapide dans une feuille 

Pour vous déplacez rapidement d’un endroit à l’autre d’une feuille de calcul, utilisez la                           
combinaison de touches ci-dessous, selon l’emplacement à rejoindre : 

- "Ctrl" +  "Flèche Haut" 

- "Ctrl" +  "Flèche Bas" 

- "Ctrl" +  "Flèche droite" 
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- "Ctrl" +  "Flèche gauche" 

Mettre en forme les données dans la feuille de calcul 

Pour saisir du texte ou des données dans votre feuille de calcul, il vous suffit de cliquer dans                                   
une cellule et de commencer la saisie. Par défaut, les données sont saisies au format                             
"Normal".  Aucune mise en forme particulière n'est appliquée à ce que vous saisissez. 

Pour formater les cellules sélectionnées dans votre feuille de calcul, utilisez les menus et la                             
barre d'outils. 

Mise en forme courantes 

Voici une liste des principales actions qu’il est possible d'appliquer à une ou plusieurs cellules : 

- Modification du format (nombres, dates, devises) 

- Modification de la police et de taille  

- Mise en forme des cellules (gras, italique, barré) 

- Modification de la couleur du texte ou/et de la couleur de couleur de remplissage 

- Ajout de bordure avec choix de la couleur et du style 

- Fusion de cellules 

- Alignement du texte (horizontal, vertical) 

- Retour à la ligne (laisser dépasser, retour automatique, tronquer) 

Mise en forme de cellules non adjacentes 

Outre la mise en forme courante, les actions suivantes peuvent être effectuées sur des                           
cellules non adjacentes : 

- Suppression de valeurs 

- Actions (Annuler, Répéter) 

- Collage de valeurs (dans les cellules sélectionnées) 

- Calcul d’une somme rapide 

- Utilisation dans des formules et graphiques 
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Sauts de ligne dans une cellule 

Pour ajouter un saut de ligne à une cellule, placez le curseur dans une                           
cellule et utilisez la combinaison de touche Ctrl+Entrée. 

 

Format des cellules 

Pour modifier le format d’une ou de plusieurs cellules, depuis la barre                       

d’outils, cliquez sur le bouton . Vous pouvez alors appliquer                   
différents formats à vos données. Tels que Devise, Pourcentage, Date,                   
Heure, Texte brut (les nombres sont traités comme du texte et non                       
comme des valeurs numériques à interpréter). 

Il est également possible de créer d’autres formats spécifique avec                   
Autres formats > Format de nombre personnalisé… 

Taille des cellules 

Pour modifier la taille (hauteur, largeur) d’une ou de plusieurs                   
cellules, sélectionner avec votre souris la colonnes ou la ligne                   
correspondant aux cellules concernées.  

Faite alors un clic-droit > Redimensionner la(les)             
ligne(s)/colonne(s)... 

Vous devrez alors spécifier dans une nouvelle fenêtre la valeur                   
souhaitée. 
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Sélection de cellules 

Pour sélectionner une cellule, il suffit de se placer dessus. Pour sélectionner plusieurs                         
cellules il faut distinguer deux cas bien distinct  : 

- Les cellules sont côtes à côtes . On dira qu'elles sont “adjacentes”. 

- Les cellules sont éparpillées dans la feuille. On dira qu'elles sont “non-adjacentes”. 

Sélectionner des cellules adjacentes 

Avec la souris : Passez sur les cellules à formater en partant du point gauche supérieur et                                 
déplacer la souris en tenant le bouton gauche appuyé jusqu’à la cellule droite inférieure. 

Avec le clavier : Placez vous sur la 1ère cellule (en haut à                         
gauche de la sélection) puis enfoncez la touche “Shift” (Flèche                   
au-dessus de CTRL). En maintenant cette touche enfoncée,               
agrandissez la sélection avec les flèches de direction.  

*A utiliser si vous avez beaucoup de lignes ou de colonnes à                       
sélectionner car la souris est parfois trop rapide. 

Information : Vous pouvez également sélectionner toutes les cases d’une ligne ou d’une                         
colonne  avec la combinaison “Shift” + “Ctrl” + “Flèche” . 

 

Sélectionner des cellules non-adjacentes 
Pour mettre en évidence des cellules non-adjacentes, utilisez la souris en                     
cliquant sur les cellules à sélectionner une à une en maintenant la touche                         
Ctrl enfoncée. 

Sélection diverses 

Sélectionner toute la feuille :  

Un clic dans le carré à droite du A et en Haut du 1 permet de                               
sélectionner toute les cases. 

Sélectionner des lignes (ou colonnes) :  

Cliquez sur le numéro de la ligne à sélectionner (partie grise).  

Si il y en a plusieurs à sélectionner étendez la sélectionnez de                       
la même façon que pour les cellules adjacentes (étendre la                   
sélection vers le haut ou le bas) ou non-adjacentes (par clic +                       
ctrl). *idem pour les colonnes. 
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Fusionner des cellules 

Pour fusionner plusieurs cellules en une seule, il vous suffit de sélectionner les cellules à                             

fusionner et de cliquer sur le bouton   depuis la barre d’outils. 

En cliquant sur la petite flèche à droite du bouton de fusion, vous avez également la                               
possibilité de choisir d’autres proposition : 

- Tout fusionner 

- Fusionner horizontalement 

- Fusionner verticalement 

- Annuler la fusion 

Pour annuler une fusion , sélectionner la cellule et appuyer sur le bouton fusion (ou annuler la                               
fusion avec la petite flèche). 

Liste déroulante dans une cellule 

Il est possible de créer des listes déroulantes dans des cellules individuelles à l’aide de l’outil                               
de validation des données. Vous pouvez soit créer une liste par rapport à une plage de                               
cellules ou depuis une liste personnalisées. 

Validation d’une plage 

1. Saisir des données dans une plage de cellules. 

2. Sélectionner la cellule à valider. 

3. Dans la barre de menu Données > Validation… 

4. Dans  “Critères” , sélectionnez “Liste créée à partir d’une plage”. 

5. Spécifiez la plage créer en 1. 

6. Cliquez pour terminer sur Enregistrer  pour valider les paramètres. 
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Liste personnalisée 

1. Saisir des données dans une plage de cellules. 

2. Sélectionner la cellule à valider. 

3. Dans la barre de menu > Données > Validation… 

4. Sélectionnez la case “Saisir les éléments de liste” . 

5. Saisissez alors des valeurs séparées avec une virgule. 

6. Cliquez sur Enregistrer pour visualiser votre liste déroulante personnalisée. 

 

   

 

 

 

 
 

62/125 



 

Les séries automatiques 

Google sheets peut également saisir à votre place une suite logique de données.  

Par exemple : Entrez 1 et 2 dans des cellules adjacentes. 

 

Sélectionnez la plage des 2 cellules et cliquez ensuite sur le petit carré en bas à droite de la                                     
sélection. 

Étendez la sélection vers le bas de quelques lignes. Vous voyez au fur et à mesure ce qui sera                                     
inscrit dans les cellules. 

 

Lâchez la souris. la série est automatiquement saisie. 

 

Cela fonctionne aussi en ligne et sur d’autres types de séries : 
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Utiliser les lignes, les colonnes et les feuilles 

La structure d'une feuille de calcul se compose de lignes et de colonnes de cellules                             
remplies de données . Chaque grille de lignes et de colonnes forme une feuille individuelle. 

Ajouter une ligne ou une colonne 

1. Sélectionnez n'importe quelle cellule devant se trouver à côté de                   
la nouvelle ligne ou colonne. 

2. Dans la barre de menus, cliquez sur Insertion, puis ajouter une                     
ligne ou une colonne. 

 

Information : Pour ajouter plusieurs lignes ou colonnes à la fois, commencez par                         
sélectionner autant de lignes ou de colonnes que vous voulez en insérer.  

Le menu "Insertion" vous permet alors d'ajouter ce même nombre de lignes ou de                           
colonnes.  

Par exemple, si vous sélectionnez un bloc de deux colonnes sur trois lignes, le menu                         
Insertion propose les options suivantes : 
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Supprimer une ligne ou une colonne 

1. Sélectionnez une ou plusieurs cellules dans la ligne ou la                   
colonne que vous voulez supprimer. Si vous sélectionnez               
plusieurs cellules, vous pouvez supprimer plusieurs lignes ou               
colonnes à la fois. 

2. Dans la barre de menus, cliquez sur “Édition” , puis choisissez                   
les lignes ou colonnes à supprimer. Par exemple, si vous                   
sélectionnez les lignes 4, 5 et 6 de la colonne C, vous pourrez                         
notamment : 

- Supprimer les valeurs 

- Supprimer les lignes sélectionnées 

- Supprimer totalement la colonne 

Information : Si vous souhaitez uniquement supprimer les données des cellules (tout en                         
conservant les lignes et les colonnes existantes), sélectionnez Supprimer les valeurs. 
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Déplacer une ligne ou une colonne 

Pour déplacer des cellules, vous pouvez utiliser les fonctions Copier et Coller (dans le menu                             
Édition ou dans le menu contextuel accessible avec un clic droit). Il existe toutefois une                             
solution plus rapide : 

1. Sélectionnez la cellule ou le bloc de cellules que vous                   
voulez déplacer. 

2. Placez votre curseur sur le bord des cellules               
sélectionnées de sorte qu'il prenne la forme d'une main. 

3. Maintenez alors le bouton de la souris enfoncé et faites                   
glisser les cellules jusqu'à leur nouvel emplacement. 

4. Relâchez le bouton de la souris pour déposer les cellules                   
à l'endroit voulu. 

 

Figer les lignes et les colonnes d'en-tête 

Les premières lignes ou colonnes peuvent être des en-têtes que vous voulez garder visibles                           
en haut ou à gauche de votre feuille de calcul lorsque vous la parcourez. Dans ce cas, vous                                   
pouvez figer les premières lignes et colonnes afin de les garder affichées en permanence.                           
Vous pouvez ainsi figer jusqu'à dix lignes et cinq colonnes. 

pour figer une ligne/colonne, il vous suffit de cliquer sur Affichage > Figer les lignes ou                             
Affichage > Figer les colonnes, puis de sélectionner le nombre de lignes ou de colonnes à                             
figer.  

Dans l'exemple ci-contre, les deux lignes supérieures sont figées. Le trait plus épais sous la                           
ligne 2 l'indique. 

 

Information : Vous pouvez également “glisser-déposer” les lignes bleues pour modifier                     
rapidement le nombre de lignes ou de colonnes figées. 
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Une fois figée, la ligne d’en-tête reste alors visible lorsque vous parcourez votre feuille de                             
calcul. 

Masquer des lignes ou des colonnes 

Pour masquer des lignes ou des colonnes, sélectionner les la(les)                   
ligne(s) ou la(les) colonne(s) à masquer puis faites un clic-droit sur                     
celle-ci. Puis cliquer sur “masquer les lignes…”. 

 

Trier des données 

Dans le cas de données à trier, placez vous sur la première                       
cellule de donnée à trier puis faite Données, puis sélectionner                   
ensuite l’option qui correspond le mieux à votre cas : 

- Trier la feuille à partir de la colonne… 

- Trier la plage à partir de la colonne… 

- Trier la plage...  

Vous pouvez également trier un ensemble de données en sélectionnant directement un                       
tableau. Pour cela, sélectionner votre tableau puis faite un clic-droit > Trier la plage… 

 

Vous pourrez ainsi trier la plage plus en détail. Notamment en Trier les données par colonnes                               
et en ajoutant des critères de tris supplémentaires. 

 

   

 

 

 

 
 

67/125 



 

Mise en forme conditionnelle 

Pour mettre en place une ou des règles de mise en forme conditionnelle, il faut spécifier une                                 
cellule ou un ensemble de cellules, puis faire un clic-droit > Mise en forme conditionnelle…                             
ou encore depuis la barre de menu Format > Mise en forme conditionnelle. 

Suite à la validation, vous allez avoir accès à une nouvelle fenêtre sur le côté droit de votre                                   
feuille. Depuis cette fenêtre vous allez avoir la possibilité de définir vos critères de condition,                             
comme par exemple en fonction : 

- Du contenu (vide ou non) 

- Du texte 

- De la date (antérieure, postérieure) 

- De la  valeur (supérieure, inférieure, égal, …) 

- Ou encore choisir des conditions personnalisée 

Ensuite, vous pouvez choisir une mise en forme spécifique pour la                     
condition et si vous le souhaitez ajouter une nouvelle condition. 
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Ajouter une nouvelle feuille 

Un projet donné peut comporter plusieurs feuilles de calcul. Par exemple, une agence de                           
voyages organisant un circuit peut avoir besoin de plusieurs feuilles de calcul pour les dates,                             
les clients, le transport, les hôtels, les excursions et ainsi de suite. 

Au lieu de créer plusieurs feuilles de calcul, vous pouvez ajouter des feuilles et passer de                               
l'une à l'autre dans une même feuille de calcul, comme vous le feriez avec les onglets d'un                                 
navigateur pour parcourir différents sites Web. 

Pour ajouter une feuille : 

1. Cliquez sur le signe plus (+) en bas à gauche de votre feuille de calcul. 

 

2. Par défaut, les feuilles sont nommées Feuille 1, Feuille 2, Feuille 3 et ainsi de suite, mais                           
vous pouvez les renommer . 

 

3. Sélectionnez l'onglet de la nouvelle feuille, cliquez sur la flèche déroulante , puis                       
cliquez sur Renommer . 

Information : Pour changer rapidement l'ordre des feuilles, il vous suffit de faire un                           
“glisser-déposer”. 
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Gestion des feuilles 

Vous avez deux possibilités pour créer une nouvelle feuille dans un fichier Sheets.  

1. Depuis le menu : Insertion > Nouvelle feuille. 

2. Depuis la barre d’onglet : Cliquez sur le bouton “+”.  

 

Le bouton permet quant à lui de vérifier la feuille ou on se trouve et également de se                                     
placer sur une autre feuille. 

Avez un clic-droit sur l’onglet d’une feuille, vous avez accès à plusieurs options : 

- Supprimer  : Supprime la feuille courante. 

- Dupliquer  : Réalise une copie de la feuille sélectionnée. 

- Copier dans…  : Copier la feuille dans un autre fichier Sheets. 

- Renommer… : Renommer la feuille sélectionnée. 

- Protéger la feuille… : Permet de protéger la feuille dans sa totalité ou seulement                           
quelques cases. 

- Masquer la feuille : Cache la feuille de la liste des onglets. Pour la ré-afficher (Affichage                               
> Feuilles masqués). 

- Déplacer  : Déplacer à Gauche ou à Droite l’onglet dans le cas où il y en aurait plusieurs. 
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Protéger une feuille ou une zone 

Pour protéger une feuille ou une zone spécifique d’une feuille, il faut                       
faire un clic-droit sur la feuille en question puis Protéger la feuille. 

Il ne vous reste alors qu’à spécifier la feuille ou la zone , de cliquer                           
sur Définir les autorisations et de spécifier l’option qui vous convient                     
le plus : 

- Afficher un avertissement lorsque cette plage est modifiée. 

- Restreindre les utilisateurs à modifier cette plage 

 

Récupération des données d’une feuille dans une autre 

Pour répliquer des données d’une feuille à une autre, il faut renseigner le nom de la feuille et                                   
la le champ spécifique.  

Par exemple : pour copier la données (A1) d’un tableau de la feuille 1 dans la feuille 4, on                                     
notera la formule suivante : =feuille1!A1 

Attention : Dans le cas ou votre feuille contient des espaces ou d’autres symboles non                             
alphanumériques, vous devrez la placez entre guillemets soit.  

Dans notre exemple si la feuille 1 avait un espace : =’feuille 1’!A1 

 

 

Information : Si vous souhaitez répliquer un ensemble de cellules dans une autre feuille                           
(dans le cas d’un tableau par exemple), il vous suffit de faire un glisser en cliquant sur le                                   
carré bleu .  
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Nommer une zone 

Pour faciliter des calculs ou des recherches, vous pouvez être amené à nommer un cellule ou                               
une plage de cellule. 

1. Sélectionnez la plage à nommer. 

2. Faite un clic-droit sur la zone. 

3. Cliquer sur Définir la plage nommée.. 

4. Nommer ensuite la zone et valider avec OK. 

 

Référence relative et absolue 

Selon la tâche que vous voulez réaliser avec Google Sheets, vous pouvez utiliser soit des                             
références relatives , c'est-à-dire des références relatives à la position de la formule, soit                         
des références absolues qui font toujours référence à des cellules situées au même                         
emplacement .  

Si la lettre et/ou le numéro sont précédés d'un signe                   
dollar , par exemple $B$2, la ligne et/ou la colonne                 
possèdent une référence absolue . Les références           
relatives s'adaptent automatiquement lorsque vous les           
copiez, ce qui n'est pas le cas des références absolues. 
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Démarrer avec les fonctions 

En savoir plus avec toutes les fonctions disponibles . 

Les fonctions permettent d'effectuer facilement et automatiquement des calculs. Pour                   

accéder aux fonctions, cliquez sur le signe Sigma dans la barre d'outils d'édition. Vous                           
pouvez également cliquer sur Insertion > Fonctions dans la barre de menus.  

Vous aurez ainsi immédiatement accès à certaines des formules les                   
plus courantes telles que "SUM" (Somme) et "AVERAGE" (Moyenne). 

Pour en savoir plus sur ces fonctions et pour découvrir les autres                       
formules disponibles, cliquez sur Plus de fonctions . 

Pour utiliser les données d'autres cellules dans vos fonctions,                 
désignez les cellules par le numéro de colonne suivi du numéro de                       
ligne (A6, C2, etc.). 
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Utilisation de la fonction SUM 

L'exemple ci-dessous explique comment utiliser la fonction SUM pour additionner les                     
cellules  situées plus haut : 

1. Sélectionnez la cellule qui doit contenir la somme. 

2. Cliquez sur le bouton de fonction (signe Sigma), puis sélectionnez SUM. 

3. La fonction SUM est insérée dans la cellule. 

 

4. Sélectionnez la plage de cellules que vous voulez additionner. La plage de cellules (D2                           
à D5 dans cet exemple) est ajoutée à la fonction SUM. 

 

5. Pour afficher le résultat, appuyez sur la touche Entrée ou Tabulation. 
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Autres fonctions de calcul de base (Min, Max, SI, ET) 

- Trouver la valeur minimale dans la plage de données (B5:D5) la formule est :                           
MIN(B5:D5) 

- Trouver la valeur maximale dans la plage de données (B5:D5) la formule est :                           
MAX(B5:D5) 

Fonction Si simple :  

- IF(C5=J5;3; 2)  →  Si C5=J5 alors 3 sinon 2 

Fonction Si imbriqués : 

- IF(C5=J5;3;SI(C5=K5;1;2))   → Si C5=J5 alors 3 sinon si C5=K5 alors 1 sinon  2 

Fonction avec Si imbriqués & Et : 

- IF(C2=600;"A";IF(AND(C2>400;C2<600);"B";"C")) → Si C2=600 alors A Sinon si C2>400         
et C2<600 alors B sinon C.  

Fonctions avancées 

Filtrer vos données 

Les filtres ont comme objectif de vous aidez à consulter et analyser plus facilement les                             
données d’une feuille de calcul. Ils permettent ainsi de masquer provisoirement les données                         
dont vous n’avez pas besoin.  
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Utilisation des Filtres 

Avant l’activation du filtre, vous devez sélectionner avec votre souris les données à filtrer.                           
Voici ci-contre, un exemple avec un tableau.  

 

1. Pour activer/désactiver les filtres , il vous suffit alors de cliquer sur le bouton                           
présent dans la barre d’outils. (ou encore “ Données > Filtrer”). 

2. Les options de filtrage sont ensuite accessible en cliquant sur le bouton . 

 

Vous pourrez alors filtrer vos données par : 

- Condition : choix dans une liste de condition ou vous avez la possibilité de créez votre                               
propre condition (Ex : Cellule vide ou non, valeur inférieure à un seuil, présence d’une                             
lettre ou expression, …) 

- Valeur : pour filtrer par valeur, décochez les différents points que vous souhaitez                         
masquer puis cliquer sur OK pour valider la sélection. Vous pouvez également pour                         
aller plus vite utiliser les boutons “Tout sélectionner”, “Effacer”. 

- Recherche : Vous pouvez également spécifier directement un terme dans le champ de                         
recherche. 

Attention : Lorsque vous ajoutez un filtre, les données filtrées le sont pour toutes les                             
personnes qui accèdent à la feuille de calcul.  

 

Information : Pour éviter les écrasement de données, un seul filtre est autorisé par feuille de                             
calcul. Pour utiliser plusieurs filtres, il faut passer par les vues filtrées (développées                         
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ci-dessous). 
 

 

Les vues filtrées 

Les vues filtrées peuvent être très utile, notamment si vous avez beaucoup de données et                             
également si le fichier est partagé avec d’autre personnes. Voici les principaux cas pour                           
l’utilisation des filtres : 

- Pas de modification des données pour les autres utilisateurs. 

- Partager des filtres spécifiques avec d’autres personnes. 

- Enregistrer un filtre pour le réutiliser ultérieurement. 

Pour créer une vue filtrée, sélectionner vos données et procédez comme suit : 

1. Cliquez sur la flèche à côté du bouton de filtre et sélectionner “Créer une vue filtrée”                               
ou dans la barre de menu (Données > Vues filtrées > Créer une vue filtrée). 

 

2. La feuille va alors s’afficher avec un contour noir. Spécifiez un Nom à votre filtre et                               
appliquez ensuite votre filtre. 

 

3. Cliquez ensuite sur la croix à droite pour quitter la vue qui est sauvegardée                             
automatiquement. 

4. La vue est maintenant disponible dans la liste “vue filtrée”. 

Dans l’exemple, nous avons un filtre qui donnera uniquement les valeurs de la région centre.                             

Pour supprimer ou dupliquer une vue filtrée, cliquez sur le bouton puis cliquez sur l'option                               
souhaitée. 
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Filtrer des données pour le partage et la collaboration 

Vous pouvez grâce à des vues filtrées paramétrer à l’avance des filtres pour les personnes                             
avec qui vous partagez vos fichiers Google Sheets.  

 

Cette fonctionnalité est notamment très intéressante si vous souhaitez partager un fichier                       
uniquement en lecture , mais que vous souhaitez que les personnes puissent visualiser                       
rapidement certaines données. Méthode qui peut faire gagner un temps non négligeable. 

De plus, même si les personnes sont uniquement en droit d’accès “lecture” ils pourront créer                             
leur propre filtre avec l’option “Créer une vue filtrée temporaire” . 

Attention : Seuls les personnes ayant des droits de modification sont autorisées à créer des                             
vues filtrées accessibles aux personnes qui peuvent consulter le fichier. 
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Gestion des dates 

Décalage d’une date de plusieurs mois 

Dans le cas ou vous auriez besoin de connaître la date d’une prochaine échéance se situant x                                 
mois dans le futur ou dans le passé, vous pourriez avoir besoin de la fonction “EDATE”. 

Dans l’exemple ci-dessous, nous ajoutons 4 mois à la date du 7 Novembre 2015. Il est possible                                 
de mettre une valeur négative pour obtenir une date passée. 

- Incrémente de 4 mois la date initiale : =EDATE("07/11/2015";4) 

Il est également possible avec cette fonction d’avoir une date passée (Ex : “-4” au lieu de “4”). 

Calculer le nombre de jour (mois, année) entre deux dates 

Pour calculer le nombre de jours ou encore le nombre de mois et d’années entre deux dates,                                 
il vous suffit d’utiliser la fonction “DATEDIF” .  

Voici ci-dessous les trois cas d’utilisation de la fonction : 

- Nombre de jours entre deux dates : =DATEDIF("08/10/2015";"05/02/2016";"D") 

- Nombre de mois entre deux dates : =DATEDIF("08/10/2015";"05/02/2016";"M") 

- Nombre d'années entre deux dates : =DATEDIF("08/10/2015";"05/02/2016";"Y") 
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Fonction  ArrayFormula 

La fonction ArrayFormula permet d’afficher des valeurs issues d’une formule de tableau sur                         
plusieurs lignes et/ou colonnes, et ainsi d’utiliser avec des tableaux des fonctions non prise                           
en charge initialement.  

Syntaxe d’ArrayFormula 

La syntaxe se présente sous la forme suivante : ARRAYFORMULA(formule_tableau) 

- Formule_tableau : Plage et expression mathématique utilisant une ou plusieurs plages                     
de la même taille, ou fonction qui renvoie un résultat avec plus d’une cellule. 

Utilisation d’ArrayFormula 

Dans le cas où je souhaite avoir la somme des résultats mensuelle de deux régions, il suffit                                 
de spécifier les plages du Nord (B2:E2) et celle du Sud (B5:E5). Soit la formule et le résultat                                   
suivant : 
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Fonction Importrange 

La fonction Importrange permet d’importer une plage de cellules depuis une feuille de                         
calcul spécifique . La formule fait ainsi référence à la feuille d’origine (ou sont présentes les                             
données à importer), puis à la feuille et la cellule de destination (ou sont importer des                               
données). 

Syntaxe d’Importrange 

La syntaxe se présente sous la forme suivante : 

=IMPORTRANGE(“URL_du_Fichier”,”Feuille_et_Plage_de_données”) 

- URL_du_Fichier : récupération d’une partie de l’URL du fichier concerné.  

 

- Feuille_et_Plage_de_données : Feuille et plage à importer au format :                   
“sheet_name!plage”. 

Utilisation d’Importrange 

Pour récupérer une plage de données (A1:E6) dans une feuille qui se nomme “Feuille1” et                             
qui à comme URL “1z_LX2XB2bYWkRMg31wGaZshIZABMJ2jmiOBcx1RHGak/edit#gid=0”.  

Il faut appliquer la formule suivante : 

 

Suite à l’insertion de la formule, vous devriez avoir une fenêtre qui s’affichera pour autoriser                             
l’accès au fichier. 

 

les données présentes dans le fichier d’origine doivent alors apparaître.  
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Fonction VLOOKUP (RechercheV) 

La fonction VLOOKUP permet de rechercher des éléments de façon verticale dans le                         
document en fonction d’une clé dans la première colonne d’une plage, et affiche alors la                             
valeur d’une cellule spécifiée dans la ligne trouvée. 

 Syntaxe d’Importrange 

La syntaxe de VLOOKUP se compose de la façon suivante :  

=VLOOKUP(clé_recherche, plage, index, est_trié) 

- clé_recherche  : valeur à rechercher. Ex : 17, “Voiture” ou A3. 

- plage  : plage à renseigner pour la recherche. 

- index  : index de colonne de la valeur à afficher. 

- est_trié (facultatif, TRUE par défaut) : indique si la colonne sur laquelle s’effectue la                           
recherche est triée. 

Information : Les performances de VLOOKUP sont meilleures dans le cas ou les plages                           
sont triées et lorsque est_trié est TRUE. 
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Utilisation d’Importrange 

Dans cet exemple, VLOOKUP recherche un identifiant d’étudiant dans la première colonne                       
et renvoie la classe correspondante. 

 

Dans ce deuxième exemple, la fonction renvoie la première valeur identifiée lorsqu’il existe                         
plusieurs correspondances pour la valeur de la clé de recherche. 

 

Information : pour réaliser le même type d’analyse, mais sur des données horizontale,                         
utilisez la fonction HLOOKUP. 
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La fonction Query 

La fonction QUERY exécute sur toutes les données, une requête écrite dans le langage de                             
requête de l’API Google Visualization (similaire à du langage SQL pour les initiés). 

 Syntaxe de QUERY 

La syntaxe de QUERY se compose de la façon suivante :  

=QUERY(données, requête, en-têtes) 

- données  : plage de cellules sur laquelle effectuer la requête. 
- requête  : requête à exécuter. Elle doit être entourée de guillemets. 
- en-têtes (Facultatif) : nombre de lignes d’en-tête dans la partie supérieure des                       

données . Si cette valeur est ignorée ou correspond à -1, elle est déduite en fonction du                               
contenu de données . 

Utilisation de QUERY 

Voici ci-dessous deux exemples d’utilisation de la fonction QUERY : 

1.  Liste des étudiants qui sont “junior” et qui font de “l’art” . 

 

2.  Calcule le nombre d’étudiant qui sont “Junior”. 
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Les graphiques 

Google sheets propose également de représenter la plupart de vos tableaux sous forme de                           
graphique.  

Pour réaliser un graphique depuis un tableau, il vous suffit de sélectionner l’ensemble des                           
cases de celui-ci et de cliquer depuis la barre de menu sur  Insertion > Graphique… 

 

Éditeur de graphique 

Une fois sur la fenêtre Éditeur de graphique Google sheets va vous proposer un ensemble                             
de graphiques recommandés.  

Vous pouvez alors sélectionner celui qui correspond le mieux à votre cas, ou encore choisir                             
d’autres types depuis l’onglet Type de graphiques. 

Lorsque vous avez fait votre choix cliquez sur le bouton “Insérer” pour intégrer le graphique à                               
votre feuille Google Sheets.  
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Modification et personnalisation d’un graphique 

Suite à l’insertion du graphique, vous pouvez modifier les différentes zone de texte en                           
cliquant dessus . Vous pourrez alors modifier le texte ainsi que la mise en forme (taille,                             
couleur, gras, italique). 

 

D’autres possibilités s’offrent suite à l’insertion d’un graphique. Pour cela, cliquez sur la petite                           
flèche en haut à droite : 

- Modification avancée…  : *Développé plus bas . 

- Supprimer le graphique  : supprime le graphique de la feuille. 

- Enregistrer l’image  : enregistre le graphique sur votre poste au format png. 

- Publier le graphique : permet de publier le graphique sur une page web. 

- Copier le graphique  : créer une copie du graphique. (Ctrl+V pour le coller ensuite). 

- Déplacer vers sa propre feuille…  : Déplacer le graphique dans une feuille spécifique. 
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Modification avancée 

La modification avancée permet de personnaliser de façon plus poussée votre graphique. 

Graphique : vous pouvez modifier la mise en forme globale du graphique ainsi que le titre et                                 
l’affichage de celui-ci (Fonctionnalités). 

 

Axe : permet de modifier le titre de l’axe, sa mise en forme, et notamment de modifier                                 
l’inclinaison. Intéressant lorsque le légende et longue. 

 

Série : permet de modifier la mise en forme de chaque colonne ou ligne du graphique. Vous                                 
pouvez également inverser le positionnement de l’axe de gauche à droite. 

 

Information : Pour en savoir plus sur tous les graphiques et notamment les types de                             
graphiques pris en charge par la solution,  
 
En savoir plus →    
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https://support.google.com/docs/answer/190718?hl=fr&ref_topic=1361474. 
 

Fonction Explorer 

La fonction “Explorer” présente dans Google Sheets vous permet de                   
créer automatiquement des graphiques à partir d’un tableau que vous                   
venez de réaliser.  

Pour utiliser cette fonction, il vous suffit de cliquer sur le bouton                       
“Explorer” en bas à droite de votre document Sheets. Vous aurez ainsi différentes                         
propositions de graphiques à intégrer. 
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Impression et téléchargement 

Mise en page et impression 

Pour imprimer, vous pouvez soit cliquez sur le bouton imprimante dans la barre d’outil ou                               
encore faire Fichier > Imprimer. Vous aurez alors la fenêtre de paramètres d’impression qui va                             
s’afficher. 

Vous pouvez notamment personnaliser le résultat de l’impression : 

Options : spécifier des options sur la feuille à imprimer comme choisir d’imprimer toutes la                             
feuille ou simplement une sélection. 

Format de papier  : choisir le format de papier en sortie. 

Mise en page  : choisir le type de sortie lors de l’impression. 
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Téléchargement 

Vous pouvez également télécharger le fichier en différent               
format.  

Il vous suffit pour cela de faire Fichier > Télécharger au                     
format et de sélectionner le format souhaité. 

Astuces & Notions diverses 

Dans ce chapitre, vous trouverez des notions pour aller plus loin dans l’utilisation et la                             
compréhension de Google Sheets. 

Recherche / Remplacement 

Pour recherche des informations précise dans un fichier Google Sheets, dans la barre de                           
menu cliquez sur Édition > Rechercher et Remplacer (Ctrl+H). 

 

Depuis la fenêtre qui va s’afficher, vous allez pouvoir recherche des éléments dans tout le                             
fichier ou encore remplacer des mots. Pour cela, noter le mot à remplacer dans                           
“Rechercher”  et le nouveau mot dans le champ “Remplacer par”. 

 

Il ne vous reste alors plus qu’à remplacer les mots au fur et à mesure en cliquant sur le                                     
bouton “Remplacer” ou tout les mots d’un clic avec le bouton “Tout remplacer”. 
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Historique de révisions 

L’historique de révisions vous permet d’accéder à aux différentes                 
étapes de création de votre document. Vous pouvez ainsi revenir à                     
une version précédentes dans le cas ou les dernières modifications                   
apportées ne sont pas valides. 

Pour accéder à l’interface de révisions, cliquez dans la barre de menu                       
sur Fichier > Consulter l’historique des révisions ou sur le bouton                     
“Enregistrement en cours/Toutes les modifications enregistrés dans             
le Drive” ou encore, faite la combinaison de touches “Ctrl+Alt+Maj+G”. 

Vous accéderez alors à l’interface à droite de votre document. Depuis                     
cette interface, vous allez pouvoir sélectionner les différentes               
étapes de modification du document, afficher ou non les                 
modifications en surbrillance et afficher les étapes intermédiaires               
en cliquant sur le bouton “Afficher plus de détails” . 

Mise en forme rapide 

Pour copier la mise en forme (caractère, taille, couleur, …) d’une cellule ou d’un ensemble de                               

cellules, utilisez l’icône avec le rouleau de peinture . Pour appliquer une mise en forme : 

1. Placez vous tout d’abord sur la cellule à copier. 

2. Cliquez ensuite sur le bouton. 

3. Puis sélectionner la ou les cellule(s) où appliquer la mise en forme. 

Effectuer un collage spécial 

L’option collage spécial vous permet de copier des données de façon plus précise.  
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Vérifier l’orthographe dans une feuille 

Pour vérifier si votre feuille de calcul ne présente pas des fautes d’orthographes et avoir des                               
suggestions de correction, utilisez le correcteur orthographique. 

1. Cliquez sur la cellule ou les plages de cellules à vérifier. 

2. Dirigez vous vers la barre de menu > Outils > Orthographe. 

3. Si le correcteur trouve un mot qui lui semble incorrect, il va vous proposez le                             
remplacer . Si vous le souhaitez vous pouvez évidemment Ignorer la proposition. 

4. Pour terminer la vérification cliquer la croix X. 

 

Sélecteur de date 

Le sélecteur de date permet de choisir une date dans une fenêtre pop-up de calendrier. Pour                               
afficher le sélecteur, il vous suffit de double-cliquez dans une cellule contenant une date. 

 

Pour être sûr que votre feuille soit bien au format jj-mm-aaaa. Dirigez vous vers Fichier >                               
Paramètres de cette feuille de calcul  pour vérifier les paramètres régionaux . 

Garder la mise en forme des cellules 

Si vous souhaitez copier des données d’une cellules ou d’un ensemble de cellule et garder la                               
mise en forme de la cellules ou de l’ensemble des cellules de destination, il vous suffit de                                 
copier les données avec les raccourcis clavier “Ctrl+Maj+V” .  
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Tableau croisé dynamique 

Un tableau croisé dynamique vous permet de créer des rapports sous forme de tableau                           
dynamique qui vous permettent d'interpréter des données de différentes manières sans avoir                       
à saisir de formule. Ces rapports sont particulièrement utiles lorsque vous voulez restreindre                         
un ensemble de données volumineux ou analyser les relations entre différents points de                         
données. 

Avant de voir en détails l’utilisation des tableaux croisés dynamiques, voici des notions à                           
connaître pour générer correctement un rapport : 

- Organisez vos données dans des colonnes. 

- Les feuilles de calcul Google détectent automatiquement les plages de cellules pour                       
votre tableau croisé dynamique. 

- Faites glisser les champs vers d'autres catégories pour modifier rapidement et                     
facilement votre analyse des données. 

- Vous pouvez créer plusieurs rapports sous forme de tableaux dynamiques croisés à                       
partir du même ensemble de données. Il vous suffit de repartir de la source de                             
données pour générer un nouveau rapport. 

- Les tableaux croisés dynamiques créés dans Microsoft Excel peuvent être importés et                       
convertis en feuilles de calcul Google. 
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Créer un rapport en tableau croisé dynamique 

Pour créer un rapport sous forme de tableau croisé dynamique à partir                       
des données d’une feuille de calcul, il faut procéder comme suit : 

1. Depuis la barre de menu > Données > Tableau croisé                   
dynamique… 

2. Saisissez alors le champ des données à prendre e compte. 

3. Une nouvelle feuille va alors être générée “Rapport de tableau                   
croisé dynamique”. Elle va contenir pour le moment un rapport                   
vide. 

4. Dans l'éditeur de rapport (fenêtre à droite), sélectionner les                 
champs à ajouter aux catégories Lignes, Colonnes , Valeurs ou                 
Filtrer du rapport. 

5. Vous pouvez ensuite modifier l’organisation des données en               
faisant glisser les champs vers d’autres catégories . 

 

Information : il n’est pas possible d’ajouter un même champ à plusieurs catégories, car cela                             
entraînerait des doublons dans les calculs du tableau croisé dynamique. 
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Tri, synthèse et filtrage d’un tableau croisé dynamique 

Suite à l'ajout des champs à votre tableau croisé dynamique, vous pouvez trier, synthétiser,                             
filtrer des données, ou encore ajouter des formules. Voici ci-dessous en détail comment                         
procédez. 

Trier des données  

Vous pouvez trier les champs Catégories, Lignes et Colonnes en ordre                     
croissant ou décroissant. Pour modifier l’ordre, cliquez sur le menu                   
déroulant en bas d’un champ de la catégorie Ligne ou Colonnes. 

Synthèse des données  

Vous avez la possibilité de trier les champs de la catégorie Valeurs par                         
fonction. Pour modifier l’ordre de tri, cliquez sur le menu déroulant en                       
bas du champ et sélectionnez l’ordre de tri des données. 

Filtrage des données 

L’ajout d’un champ depuis la catégorie Filtrer permet de masquer les                     
points de données que vous ne voulez pas voir apparaître.  

Pour filtrer les données de votre tableau, cliquez sur le menu déroulant                       
en bas d’un champ de la catégorie Filtrer. Cochez ensuite la case que                         
vous voulez afficher ou masquer. 

Utilisation des formules 

En plus de l’utilisation du tableau croisé dynamique, vous pouvez affiner                     
votre analyse en saisissant des formules en dehors de votre rapport. Les formules vont traiter                             
les valeurs du tableau croisé dynamique comme dans les cellules de données normales. 
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Partage & Collaboration 

Partagez votre feuille de calcul avec d'autres personnes et profitez des fonctionnalités                       
collaboratives des feuilles de calcul Google. Plusieurs personnes peuvent modifier une même                       
feuille de calcul simultanément — la version la plus récente est toujours à portée de main. 

Pour partager une feuille de calcul, cliquez sur le bouton Partager en haut à droite de la page.                                   
Pour en savoir plus sur les paramètres de partage, consultez le document Partager et                           
collaborer . 

Les règles de collaboration dans les feuilles de calcul sont légèrement différentes de celles                           
applicables aux documents : une cellule ne peut être modifiée que par une seule personne à                             
un instant T et chaque commentaire est associé à une cellule donnée.  

Collaborer par modifications simultanées 

La cellule que vous avez sélectionnée est surlignée en bleu. Si une autre personne modifie la                               
feuille de calcul en même temps que vous, la cellule qu'elle a activée présente une bordure                               
de couleur différente. 

Si vous voulez savoir qui a sélectionné une cellule, placez le pointeur de la souris dessus. 

 

Dans les feuilles de calcul Google, vous ne risquez pas d'écraser les modifications effectuées                           
par une autre personne. Une cellule en cours de modification apparaît grisée. 

 

Si vous essayez d'éditer une cellule grisée, vos modifications ne seront pas prises en compte. 
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Collaborer à l'aide de commentaires 

Si vous êtes autorisé à commenter une feuille de calcul, vous pouvez ajouter des                           
commentaires dans des cellules individuelles. 

Pour ajouter un commentaires, sélectionnez la cellule à laquelle vous souhaitez ajouter un                         
commentaire, puis Cliquez sur Insertion > Commentaire ou utilisez le menu contextuel                     
accessible par un clic droit.  

 

Saisissez alors votre commentaire. Il sera automatiquement signé de votre nom et horodaté. 

Cliquez dans une autre cellule. Vous pouvez alors constater que l'angle supérieur droit de la                             
cellule dans laquelle vous avez ajouté un commentaire comporte un triangle orange. 
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Pour afficher l'ensemble des commentaires , il vous suffit de placer le pointeur de la souris                             
sur la cellule. Vous verrez alors la totalité de la discussion. 

 

Si vous voulez modifier votre commentaire , cliquez sur la cellule, puis sélectionnez                       
“Modifier” ou “Supprimer”.  

Pour répondre au commentaire d'une autre personne, saisissez votre réponse dans le champ                         
Répondez à ce commentaire qui s'affiche lorsque vous cliquez sur la cellule.  

Une fois que vous n'avez plus besoin des commentaires associés à une cellule, cliquez sur                             
cette dernière, puis sélectionnez Fermer la discussion pour supprimer le fil de commentaires. 
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Être informé suite à une modification 

Si vous souhaitez être informé lors lors de la modification d’un fichier                       
Google Sheets partagé avec d’autres personnes, il vous suffit de                   
procédez comme suit : 

Depuis le fichier Sheets en question, cliquez sur Outils > Règle de                       
notification . 

Une fois sur la fenêtre des règles de notification, il ne vous reste qu’à                           
spécifier la façon de notification qui vous convient le mieux. 
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Aide Google Sheets 
L’un des fonctionnalités vous permettant d’en savoir plus est                 
la partie Aide de la solution.  

Il vous suffit pour y accéder de cliquer sur l’onglet du même                       
nom dans la barre du menu.  

Vous y trouverez notamment : 

- Aide relative aux feuilles de calcul : Aide basique                 
d’utilisation de l’application. Vous pouvez renseigner une             
question pour trouver rapidement une solution à un problème. 

- Liste des fonctions : Ouvre une page web où vous trouverez                     
une liste avec toutes les fonctions disponible pour               
l’application. 

- Raccourcis clavier : Tous les raccourcis clavier disponible               
pour gagner un peu de temps lors de l'utilisation de Google                     
Sheets. 
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Google Forms : Formulaires et enquêtes 
 

Environnement de Google Forms 
La solution Google Forms de la suite Google Apps vous permet de réaliser simplement et                             
rapidement des enquêtes et des formulaires de différents type publiable sur le Web. Vous                           
pouvez ainsi avoir l’avis de nombreuses personnes sur un sujet et analyser ensuite les                           
données sur un fichiers Google Sheets. 
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Composition du menu de création Google Forms 

Un fichier de création de formulaire se compose de plusieurs zones spécifique. Voici un tour                             
d’horizon d’un fichier vierge avec de passer à la création d’un formulaire à proprement parler. 

Zone de conception : permet d’agir sur la mise en forme, d’afficher les réponses ou encore d’afficher 
la version publiée. 

Palette de couleur : personnaliser le formulaire en sélectionnant une autre couleur ou un autre 
thème parmi une large sélection. 

Aperçu : visualiser le résultat final du formulaire dans une autre fenêtre. 

Paramètres : permet de modifier des options comme les personnes autorisées à répondre et les 
options de présentation. 

Barre d’édition Google Forms : permet de choisir les critères d’une question, d’ajouter un nouveau 
champ, etc. 

Envoyer : paramètres liés à la publication du formulaire. 
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Création d’un formulaire 

Créer un formulaire 

Pour créer un formulaire depuis Google Drive, il vous                 
suffit de cliquer sur le bouton Nouveau, puis Plus >                   
Google Forms . 

Vous allez ensuite accéder à la page de création de                   
votre formulaire Google Forms. Pour donner un nom               
à votre formulaire, cliquez sur Formulaire sans titre .  

 

Vous pouvez ensuite la renommer à tout moment en cliquant à nouveau sur le titre. 

Créer un formulaire depuis Google Sheets 

Pour créer un formulaire depuis Google Sheets : Menus , Insertion > Formulaire .  

Un message indiquera la création d’un formulaire. 
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Conception d’un formulaire 

Barre d’édition du formulaire 

La barre d’édition de Google Forms vous permet d’ajouter les éléments suivant à 
la zone de conception : 

- Une question 
- Un titre est une description  
- Une image 
- Une vidéo 
- Une rubrique (section)  

Les questions 

Après la création du formulaire, ajoutez des questions auxquelles les interlocuteurs pourront 
répondre. Vous avez accès à plusieurs type de questions possible. Pour ajoutez une 
questions, cliquez sur le bouton +. 

Les types éléments 

Pour choisir un élément particulier, sélectionnez le type de question en cliquant que la flèche  en 
face d’”Ajouter un élément”.  

Vous avez le choix entre 4 types d’élément : 

- Simple : 
- Réponse courte 
- Paragraphe 

- Complexe : 
- Choix multiples 
- Cases à cocher 
- Listes déroulante 

- Mise en page : 
- Échelle linéaire 
- Grille à choix multiples 

- Horaires : 
- Date 
- Heure 

Suite à la sélection vous pouvez agir encore sur la question, avec les éléments présents en bas de la 
question ajoutée, soit : 

- Rendre obligatoire la réponse à la question. 
- Dupliquer la question. 
- Supprimer la question. 
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- Les trois points verticaux : options supplémentaires spécifiques au type de la question. 

Ajouter un titre 

Pour ajouter un titre au sein d’une rubrique, cliquez sur le bouton , spécifiez le titre et une 
description si vous le souhaitez. 

Ajouter une image ou une vidéo 

Si vous le souhaitez, ajoutez un élément de type “média” comme une image ou encore une 
vidéo à votre formulaire. Ces types d’éléments permettent d’aller plus loin en étant plus 
précis sur les questions à poser. 

Pour ajouter ce type d’élément, sélectionnez le bouton correspondant ou depuis le 
type mise en page. 

Ajouter une rubrique (section) 

Pour ajouter une rubrique spécifique dans votre formulaire, cliquez sur le bouton présent 
dans la barre d’édition de votre formulaire. Une nouvelle rubrique apparaîtra comme 
ci-dessous : 

 

Donnez un titre de section à la rubrique et si vous le souhaitez réduisez la taille de chacune 

d’entre elle en cliquant sur le bouton . Ceci vous permet de visualiser plus facilement les 
questions présentes dans chaque rubrique. 

Le bouton vous permet quant à lui de réaliser les actions suivantes : 

- Dupliquer la section 
- Supprimer la section 
- Fusionner avec l’élément supérieur (impossible pour la 1ère rubrique) 
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Accéder à une rubrique (section) selon la réponse 

Certains types de questions permettent de diriger directement les personnes vers une autre rubrique 
du formulaire. 

Par exemple avec une question à choix multiples : 

- Si une personne répond “oui” elle accédera à la section 
2, 

- Si c’est “non”, elle passera directement à la section 3.  

 

 
 

Information : Il n’est actuellement pas possible de rediriger vers une question sans créer au préalable un 
saut de page. 

 

Les réponses 

Le menu réponse de votre formulaire vous permet de 
gérer en détail la façon dont vous souhaitez traiter les 
résultats. 
 
Depuis ce menu, vous obtenez directement un résumé 
des résultats sous différentes formes afin de bien 
interpréter et analyser le résultat. 
 
Vous pouvez également : 
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- Accéder au document Sheets associé avec le bouton  
- Stopper les réponses au formulaire en décochant “Réponses acceptées”. 

- Utiliser des options supplémentaires avec le bouton : 
- Sélectionner la destination des réponses 
- Supprimer le lien vers le formulaire 
- Télécharger les réponses (.csv) 
- Supprimer toutes les réponses 

Destination des réponses 

Lors de l’envoi d’un formulaire à des personnes, vous pouvez choisir de récupérer leurs 
réponses dans une feuille de calcul Google Sheets ou alors directement depuis le formulaire. 

1. Cliquez sur le bouton  présent dans le 
Réponses présent en haut du formulaire. 

2. Puis Sélectionnez la destination des 
réponses… 

3. Sélectionnez alors l’une des deux options 
proposées : 

○ Nouvelle feuille de calcul 
○ Nouvelle feuille dans une feuille de 

calcul existante… 

4. Valider par le bouton Créer . 

Télécharger au format csv 

Si vous souhaitez traiter les données ailleurs que depuis un document Google Sheets, vous pouvez 
télécharger les résultats sous forme d’un fichier de type csv :  

1. Cliquez sur le bouton présent dans l’onglet 
Réponses présent en haut du formulaire. 

2. Puis Télécharger les réponses (.csv) 

 

Supprimer le lien avec le formulaire  

Lors de la collecte des réponses aux questions de votre formulaire dans une feuille de calcul Google                                 
Sheets, votre Drive contient deux éléments associés : Le formulaire et la feuille de calcul.  
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Vous pouvez à tout moment supprimer le lien entre les deux                     
fichiers depuis votre formulaire : 

1. Cliquez sur le bouton  présent dans  l’onglet 
Réponses. 

2. Supprimer le lien vers le formulaire… 

Information : lors de la suppression de l’un de ces fichiers depuis Google Drive (formulaire, feuille de 
calcul), le document associé n’est pas supprimé. Ainsi vous conservez la feuille de résultat après la 
suppression du fichier Forms. 

Supprimer les réponses à partir du formulaire 

Vous pouvez supprimer les réponses d’un formulaire 
directement à partir du menu Réponses.  

Cliquez ensuite sur puis sur le bouton Supprimer toutes les 
réponses pour réinitialiser la feuille de calcul.  

Changer de couleur ou thème 

Pour changer de thème ou simplement modifier la couleur de 

fond du formulaire, cliquez sur le bouton Palette de couleur . Vous accédez alors à la palette de 
choix d’une couleur. Pour personnaliser le thème plus précisément, cliquez sur l’icône en bas à droite 

de la palette . 

Sélectionner un thème 

Dans la fenêtre de sélection de thème, faites votre choix parmi une large sélection de thème : 

- Illustrations 
- Anniversaire 
- Alimentation et restauration 
- Fête 
- Pour les enfants 
- Mariage 
- Soirée en ville 
- Sports et jeux 
- Voyages 
- Autres 

Vous pouvez aussi importer une photos depuis votre 
ordinateur et choisir un thème différent pour les 
questions et les réponses au formulaire. 
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Paramètres du formulaire 

Depuis le bouton paramètre , accédez à des options 
permettant d’optimiser encore plus votre formulaire : 

- Personnes autorisées à répondre : 
- Choisir si tout le monde peut répondre au 

questionnaire 
- Autoriser une seule réponse [par utilisateur] 

(connexion obligatoire) 
 

- Page de confirmation : 
- Modifier le message reçu après avoir répondu au 

formulaire. 
- Possibilité de fournir un lien aux personnes 

interrogées pour : 
- Envoyer une autre réponse 
- Modifier ses propres réponses 
- Afficher le résumé des réponses 

- Options de présentation : 
- Afficher la barre de progression ou non. 
- Trier les questions en mode aléatoire ou non. 

Menu “Autres”  
Vous pouvez notamment depuis ce menu : 

- Créer une copie 
- Déplacer le formulaire vers un autre dossier 
- Placer le formulaire dans la corbeille 
- Obtenir le lien de partage 
- Imprimer le formulaire 
- Ajouter des collaborateurs (éditer à plusieurs) 
- Centre d’aide (avoir plus d’informations sur la solution) 
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Partager et collaborer sur un formulaire 
Sur Google Forms, vous pouvez partager et collaborer à plusieurs sur 
un formulaire. 

Pour ajouter des collaborateurs et ainsi activer le partage, cliquez sur 
en haut à droite du formulaire puis sur “Ajouter des 
collaborateurs…”.  

Ajouter l’adresse des collaborateurs dans la zone ci-dessous : 

 

Lors de l’édition d’un formulaire en collaboration, chacun des utilisateurs ne peut modifier 
qu’un seul champ à la fois. Si vous éditez une question, une autre personne ne pourra pas la 
modifier en même temps.  

Envoyer le formulaire 
Une fois votre formulaire terminé, vous pouvez le partager de plusieurs façons. Cliquez alors 
sur le bouton “Envoyer”  en haut à droite du formulaire.  
 
Vous accédez alors à une nouvelle fenêtre depuis laquelle vous allez choisir : 

✓ Les personnes autorisées à répondre. 

✓ Autorisées à répondre plus d’une fois 
ou non au formulaire. 

✓ Le mode de diffusion : 

○ Email 
○ Réseaux sociaux 
○ Lien 
○ Intégrer à une page internet 
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Google Drawings : Dessin 
 

Environnement de Google Drawings 
Depuis l’application Google Drawings vous avez la possibilité de créer, partager et modifier 
simplement des dessins en ligne. 
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Composition du menu de création Google Drawings 

Un fichier de dessin de type Google Drawings est composé des zones suivantes : 

- Barre d’outils  : toutes les commandes disponibles sont accessibles depuis ce menu. 

- Barre d’édition Google Drawings  : permet d’utiliser la plupart des outils disponible et 
spécifique à l’application. 

- Zone de dessin  : zone de création du dessin. 

- Collaboration et partage  : bouton pour activer et gérer le partage et la collaboration 
sur le fichier. 
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Manipulation et notions de base 

Création d’un fichier Google Drawings 

Pour créer un dessin depuis Google Drive, il vous suffit de                     
cliquer sur le bouton Nouveau, puis Plus > Google                 
Drawings . 

Vous allez ensuite accéder à la page de création de votre                     
formulaire Google Drawings. 

Pour donner un nom à votre fichier, cliquez sur Dessin sans                     
titre . 

Vous pouvez ensuite la renommer à tout moment en                 
cliquant à nouveau sur le titre. 

Options de la barre d’outils 

Édition 

Permet d’effectuer des manipulation basique comme couper, copier, coller, dupliquer et 
modifier une forme. 
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Insertion 

Permet d'utiliser la plupart des outils disponibles pour l’application.  

Soit les éléments suivants : 

- Zone de texte : ajouter une zone de texte au dessin. 

- Image  : insérer une image depuis une source externe. 

- Lien  : insérer un lien sur un élément du dessin. 

- WordArt  : ajouter du texte de type “WordArt”. 

- Trait  : permet d’ajouter un trait de plusieurs type au dessin : 
- Trait 
- Flèche 
- Connecteur en angle 
- Connecteur en arc 
- arc 
- Polyligne 
- Dessin à main levée 

- Forme  : permet d’insérer des formes spécifiques : 
- Formes 
- Flèches 
- Légendes 
- Équation 

- Tableau  : insérer un tableau et choisir le nombre de lignes ou colonnes. 

- Commentaire  : permet d’ajouter un commentaire sur le dessin. 

 

Information : lorsque vous êtes en mode “trait”  (flèche ou autre), vous pouvez continuer 
à ajouter des traits jusqu’à se que vous repassiez en mode “sélection” (bouton curseur de 

souris ) ou en appuyant sur la touche Echap de votre clavier. 

 

Format 

Le menu Format permet de modifier des éléments comme l’arrière-plan du dessin, et de 
gérer la mise en page et l’ordre d’affichage de ceux-ci. 
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Barre d’édition de Google Drawings 

 

La barre d’édition de Google Drawings vous permet d’insérer et d’agir rapidement sur votre 
dessin. Voici les possibilités offertes par cette zone : 

- Imprimer : lancez une impression du dessin courant. 

- Annuler / rétablir des modifications : annule ou rétablie une action courante. 

- Appliquer la mise en forme  : applique une mise en forme existante à un élément. 

- Zoom avant ou arrière  : adapter la visibilité du dessin. 

- Formes  : insérer des formes diverses rapidement. 

- Image : insérer une image depuis un endroit externe. 

- Couleur de remplissage, de trait, d’épaisseur, … : ces options sont disponibles une fois 
qu’un élément spécifique comme une zone de texte est inséré. 

- Commentaires : insérer un commentaire sur le zone du dessin. 

Information : si vous souhaitez dupliquer une forme, maintenez la touche Ctrl enfoncée tout 
en faisant glisser la forme correspondante.  

 

Modifier la taille du dessin 

Pour modifier la taille de votre dessin, procédez comme suit : 

1. Cliquez sur me menu Fichier > Configuration de la page . 

2. Sélectionnez une taille depuis le menu déroulant, soit : 
○ Standard (4:3) 
○ Grand écran (16:9) 
○ Grand écran (16:10) 
○ Personnalisée : permet de préciser les dimensions de votre dessin et 

sélectionner les unités correspondantes (pouces, centimètres, pixels). 
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Mise en forme du dessin 

Suite à l’insertion d’éléments sur votre zone de dessin, vous allez pouvoir modifier la mise en 
forme de ceux-ci à l’aide des boutons présents dans la copie d’écran suivantes : 

 

Vous allez ainsi pouvoir suite à l’insertion d’un éléments (forme, texte) : 

- Modifier la couleur de remplissage et de trait. 

- Modifier l’épaisseur du trait du style (tirets). 

- Augmenter ou diminuer la transparence. 

- Modifier le style, la couleur d’écriture et autres mises en forme... 

- Ajouter des liens externes. 

- Ajouter un commentaires sur un élément. 

Information  : pour modifier la couleur  d’arrière-plan du dessin, faite un clic-droit dans la 
zone de dessin  puis sélectionner Arrière-plan et enfin la couleur souhaité. 

 

 

Sélection et manipulation d’objets 

Manipulation de plusieurs objets 

Pour sélectionner et manipuler plusieurs objets à la fois,                 
appuyez sur la touche Maj de votre clavier et faites ensuite                     
glisser la souris  à l’emplacement souhaité. 

Par exemple pour déplacer deux flèches à un autre endroit du                     
dessin comme dans le cas ci-contre. 

Pour désélectionner un objet maintenez à nouveau la touche                 
Maj et cliquez ensuite sur l’objet. 
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Aligner ou faire pivoter la sélection 

Suite à la sélection de deux éléments vous pouvez également adapter facilement le                         
positionnement. Pour ce faire, faite un clic-droit sur les éléments “scindés” . 

Vous allez alors pouvoir appliquer les options suivantes aux éléments sélectionnés : 

- Faire pivoter : 
- 90° à droite 
- 90° à gauche 
- Verticalement 
- Horizontalement 

- Centrer sur la page  (Horizontalement, verticalement). 

- Aligner horizontalement. 

- Aligner verticalement. 

- Associer : scinde les images en une seul. 

- Commentaire : annoter un commentaire sur la sélection en                 
cours. 

Outre le clic-droit, vous pouvez également effectuer cette opération depuis le menu                       
Réorganiser . Dans le cas ou vous auriez sélectionné au moins trois objets, vous avez la                             
possibilité de les positionner à égale distance les uns des autres sur le plan horizontal ou                               
vertical en sélectionnant Réorganiser > Distribuer . 

Vous pouvez également maintenir cette association en cliquant avec le bouton droit de la                           
souris sur l’un des objets puis en sélectionnant Associer ou depuis le menu Réorganiser >                             
Associer . Lorsque les objets sont associés, vous pouvez alors les manipuler comme s’il                         
s’agissait d’un objet unique. 

Pour gagner un peu de temps, Vous pouvez également utiliser les raccourci clavier : 

- appuyer sur Ctrl + A  pour sélectionner tous les objets 

- sur Ctrl + G  pour associer des objets 

- sur Ctrl + Maj + G  pour dissocier des objets 
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Déplacement, redimensionnement et rotation 
Pour déplacer, redimensionner et faire pivoter un objet de votre dessin, 
il vous suffit simplement de cliquez sur l’objet.  

Vous verrez alors apparaître un point de rotation en bleu, des poignées 
de redimensionnement blanches ainsi que des poignées d’ajustement 
de couleur jaunes. 

Déplacement 

Une fois un objet sélectionné, glissez le à l'aide de la souris ou des 
touches fléchées de votre clavier.  

Si vous maintenez la touche Maj enfoncée pendant que vous faites 
glisser l'objet, le déplacement suit l'axe horizontal ou vertical le plus 
proche. 

Redimensionnement 

Sélectionnez et glisser l'une des poignées (blanches) de 
redimensionnement. L'objet grossira ou rétrécira selon le mouvement 
du curseur.  

Les objets peuvent être redimensionnés à l'échelle en maintenant la 
touche Maj enfoncée  pendant que vous faites glisser une poignée 
d'angle. 

 

Rotation 

Sélectionnez et glissez le bouton bleu de rotation pour faire pivoter 
l'objet. Si vous maintenez la touche Maj enfoncée pendant cette action, 
la rotation se fera par incréments de 15°. 

Vous pouvez également faire pivoter l’objet de 90° en cliquant avec un 
clic-droit sur l’objet à pivoter (horizontalement ou verticalement). 

Remodelage 

Les objets qui peuvent être remodelés disposent de poignées jaunes. 
Faites glisser ces poignées individuellement pour modifier la forme de 
votre objet. 

 

Information : Pour déplacer, redimensionner ou faire pivoter plusieurs objets en même                       
temps, maintenez la touche Maj enfoncée pendant que vous cliquez sur chacun d'eux.                         
Vous pouvez également faire glisser votre souris sur l'arrière-plan du dessin pour                       
sélectionner plusieurs formes. 
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Modèles pour Google Drawings 
Pour vous faire gagner du temps dans la réalisation de dessin, de nombreux modèles 
(templates) sont également disponibles. 

Pour accéder aux modèles disponibles depuis un nouveau fichier Google Drawings, cliquez 
depuis la barre de menu sur Fichier > Nouveau > A partir du modèle...  

 

Vous pouvez ainsi avoir accès à un grand nombre de modèles public disponible gratuitement 
par la communauté de l’application. Pour utiliser un modèle trouvé, il vous suffit de cliquez 
sur le bouton Utiliser ce modèle afin qu’il se charge dans un nouveau document. 

Autres ressources 

Pour aller plus loin, voici des sites proposant des modèles pour l’application : 

- http://ditchthattextbook.com 
- http:// appsusergroup.org 
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Aller plus loin avec Google Drawings 

Si vous souhaitez apprendre à maîtriser pleinement le potentiel du l’application de dessin de                           
Google ou/et si vous doutez du potentiel de cet outil, je vous recommande d’aller jeter un                               
coup d’oeil sur le site de Joshua Pomeroy ( http://www.joshuapomeroy.com/) ou encore                     
d’apprendre par le biais de ses vidéos sur YouTube “Designing With Google” . 

Voici un exemple des réalisations possible avec ces portraits : 

 

Utiliser les outils bureautique Google 
Comme vous avez pu le constater, les outils bureautique de Google permettent de réaliser un                             
grand nombre de chose. Les applications développées dans ce livre peuvent notamment                       
vous permettre de réaliser, de suivre et de gérer de nombreuses tâches applicables en                           
informatique. 
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Voici ci-dessous quelques exemples d’utilisations pour utiliser chacune des applications                   
définies dans le livre. 

- Google Docs  : Des rapports, des offres, des notes de réunion... 

- Google Sheets  : Des feuilles budgétaires, des plans de projets, des listes de tâches... 

- Google Slides : Des modules de formation, des présentations d’équipe, des                     
argumentaires...  

- Google Forms  : Des sondages, des enquêtes de satisfaction... 

- Google Drawings : Des organigrammes, des maquettes, des cartes                 
heuristiques/visuelles... 
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Conclusion & remerciement 
 

L’utilisation des outils bureautique Google permet d’accéder simplement à des outils devenu                       
incontournable au fil du temps. Cette solution présente des avantages non négligeable en                         
comparaison à d’autres applications plus connues comme la suite Office de Microsoft                       
présente depuis de nombreuses années sur le marché.  

Cependant, la simplicité d’utilisation, les fonctionnalités de collaboration et de partage, des                       
mises à jours régulières, ainsi que la gratuité de la suite pour les particuliers en font une                                 
solution de choix pour le grand public. 

J’espère que ce document vous aura permis de vous approprier les applications de la suite                             
bureautique de Google. 

Bon courage avec vos projets bureautique ! 

 

   

 

 

 

 
 

123/125 



 

Informations légales 
 

Cet e-book est protégé par le droit d’auteur et bénéficie d’une protection au titre de la propriété                 
intellectuelle. Comme toute production de l’esprit, son auteur souhaite en recevoir une compensation pour              
son utilisation. Il n’hésitera pas à faire valoir ses droits en ce sens si nécessaire. 

Par conséquent : 
 

➢ La copie partielle ou complète des éléments de ce e-book n'est pas autorisée : toute reproduction                
interdite. 

➢ La modification de cet ouvrage est interdite. 
➢ La vente ou revente de ce e-book est interdite. 

 
Les droits des images jointes à ce document sont acquittés. Si une image de ce document vous                 
appartenait, veuillez nous contacter afin de résoudre le problème dans les plus brefs délais. 
 
Les marques citées dans ce document restent entièrement la propriété de leurs détenteurs, si vous               
souhaitez les retirer, contactez-moi. 
 
Ce document a été conçu pour que les lecteurs obtiennent un maximum d’informations. Le lecteur doit                
cependant être averti que les résultats obtenus (qu’ils soient positifs ou négatifs) dépendent uniquement de               
l’utilisation qui sera effectuée de l’information contenue et que l’auteur ne peut être tenu pour responsable                
de ces résultats et décline toute responsabilité à l’égard des conséquences éventuelles de l’utilisation du               
document. 
 

   

 

 

 

 
 

124/125 



 

Ressources 
 

Voici ci-dessous des sites internet ressources pour aller encore plus loin dans votre maîtrise                           
de GSuite :  

 
 

● Numeriblog : http://thierryvanoffe.com 

● Numeritube : https://www.youtube.com/channel/UCuVW0pl83QgawEaNepFlh7A 

● Fastlearner ; https://www.youtube.com/channel/UCYRZOPlFkHAt_Nw7mTT0P5Q 

● Découvrir GSuite : https://gsuitefr.blogspot.com/ 

● MyChromebook : https://mychromebook.fr/ 

● https://www.windtopik.fr/blog/ 
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